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1 Introduction

1 Introduction
Quantum is the latest visualisation software released by Hexagon | Veripos. It is designed to clearly 
display the most relevant information required for both DP and Survey operations.

Quantum is a quality, position and heading monitoring software package with a configurable graphical 
user interface. Vessels may customise displays to match specific end-user requirements and 
preferences. The views available in Quantum range from high-level, appropriate for standard operations, 
to detailed views for specific operating scenarios or troubleshooting. Users not requiring a custom 
configuration can select from predefined default page layouts.

This manual will focus on Quantum PC use in conjunction with the LD8 and LD900  Veripos receivers.

Quantum software layout example
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1 Introduction

1.1 Scope
This manual covers the following aspects of Quantum for Microsoft Windows 7 or later:

• Installation

• Interfacing to compatible Veripos receivers

• Software configuration

• Operational procedures

• Receiver configuration

1.1.1 Contents

Chapter Contents

Introduction Specifies the purpose of this manual, provides an overview of the Quantum 
software and explains the document conventions used.

Installation Describes the software installation process, minimum PC specifications and 
Veripos receiver compatibility.

Settings Describes the Quantum settings menu in detail.

Screen overview Describes the Quantum screen layout in detail.

Display Configuration Explains the configurable display options such as adding and removing 
display tabs and configuring display tiles.

Views Describes all available view options in detail.

Troubleshooting Provides basic fault-finding advice and examples of possible error states.

Reference information Provides technical specifications.

Contact information Contains contact information for the Veripos Helpdesk.

Appendix Provides additional supplementary material.
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1 Introduction

1.2 Terms and abbreviations
ACN Alert Control Input - Input to acknowledge or query alert status

ALC Alert List Cyclic - Active alerts & revision status

ALF Alert List Flag - Output of alert priority, state, & type

APEX Veripos high accuracy positioning solution

ApexTide Tide correction sources derived from Veripos PPP solutions

Baud Unit of symbol transmission rate; typically bits per second in binary systems

BEIDOU Chinese commissioned GNSS

BESTPOS / BESTGPSPOS GNSS output message with position and quality

CAM Central Alert Management

COG Course over Ground

CMR GNSS correction format

COM Communication Port

dB Decibel

DGPS Differential Global Positioning System

DHCP Dynamic Host Configuration Protocol

DOP Dilution of Precision

DP Dynamic Positioning

DQI Differential Quality Indicator

EGM96 Earth Gravitational Model 1996

EGM08 Earth Gravitational Model 2008

GALILEO European commissioned GNSS

GGA Global Positioning System Fix Data - Fix data including 3D position & accuracy

GLL Geographic Position - Latitude & longitude of the position fix.      

GLONASS GLObal NAvigation Satellite System - Russian commissioned GNSS

GNSS Global Navigation Satellite System

GP GPS talker ID prefix used in NMEA 0183 sentence types (e.g., GPGGA)

GPS Global Positioning System - United States commissioned GNSS

GRIT Veripos GNSS interference & spoofing detection module

GRS GNSS Range Residuals - Difference between measured & expected satellite ranges

GSA GNSS DOP and Active Satellites – Used satellites & DOP values

GSV GNSS Pseudorange Error Statistics - Error estimates for position fi

HDG Heading (True)

HDT True heading derived from external sensors

HDOP Horizontal Dilution of Precision

Hz Hertz

IALA International Association of Marine Aids to Navigation and Lighthouse Authorities

ID Identification
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1 Introduction

INS Inertial Navigation System

INHDT INS-derived heading in NMEA format

INSPVA INS Position, Velocity, and Attitude sentence

IMCA International Marine Contractors Association

IMU Inertial Measurement Unit

IP Internet Protocol

IPv4 Internet Protocol Version 4

LAN Local Area Network

L-band Signal transmitted to carry correction data to mobile users

LED Light Emitting Diode

NMEA National Marine Electronics Association

NTRIP Networked Transport of RTCM via Internet Protocol

MSS Mean Sea Surface

PASHR Proprietary Attitude Sentence, Heading, & Rate

PDOP Positional  Dilution of Precision

PPP Precise Point Positioning

PPP-AR Precise Point Positioning-Ambiguity Resolution

PPS Pulse Per Second

PRN Pseudo Random Noise

PSN Product Serial Number

PTP Precision Time Protocol

RAIM Receiver Autonomous Integrity Monitoring

RS232 Recommended Standard 232

RS422 Recommended Standard 422

RTCM Radio Technical Commission for Maritime Services

RTCMv2 / RTCMv3 GNSS correction formats

RTK Real-Time Kinematic

SAL Service Access License

SBAS Satellite Based Augmentation System

SD Standard Deviation

SOG Speed over Ground

Standard Veripos single-frequency DGPS correction service providing entry-level accuracy

TCP Transmission Control Protocol

THS NMEA sentence for true heading and speed

TRINAV NMEA-style output sentence

UDP User Datagram Protocol

UI User Interface

UKOOA Industry-standard NMEA-style sentence format used offshore

Ultra Veripos high accuracy position solution
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1 Introduction

UltraTide Tide correction sources derived from Veripos PPP solutions

USB Universal Serial Bus

UTC Coordinated Universal Time

VDOP Vertical Dilution of Precision

VTG Course and Ground Speed - Course (true/magnetic) & speed over ground

Wi-Fi IEEE 802.11 (wireless) standard

ZDA Time and Date – Supplies UTC time, day, month, year, & local time zone offset
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1 Introduction

1.3 Document conventions

1.3.1 Typographical conventions
Italic or bold text is used to emphasize certain information. Italic is also used in cross-references to other 
parts of the document and to other documents.

Bold text is also used for indicators and touch screen “push-buttons” commands.

Blue text is used for hyperlinking to other sections within this document or to external documents or 
websites.

Bold italic text is used when display screens are mentioned in text.

Monospace text is used for input/output strings to/from the device.

1.3.2 Special Notices

WARNING
A warning indicates the risk of bodily harm or serious damage to the hardware.

CAUTION
A caution indicates the risk of damaging the hardware or adversely impacting the 
operation of the system.

NOTE
A note contains important information to help you make better use of the system.
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1 Introduction

1.4 Disclaimer
Hexagon Autonomous Solutions division proprietary data

This document and the information contained herein are the exclusive properties of Veripos Limited, and/or their affiliates within the 
Autonomous Solutions division of the Hexagon AB group of companies (“Hexagon”).

No part of this document may be reproduced, displayed, distributed, or used in any medium, in connection with any other materials, 
or for any purpose without prior written permission from Hexagon. Applications for permission may be directed to 
contact.ap@hexagon.com. Unauthorized reproduction, display, distribution or use may result in civil as well as criminal sanctions 
under the applicable laws. Hexagon aggressively protects and enforces its intellectual property rights to the fullest extent allowed 
by law.

This document and the information contained herein are provided AS IS and without any representation or warranty of any kind. 
Hexagon disclaims all warranties, express or implied, including but not limited to any warranties of merchantability, non-
infringement, and fitness for a particular purpose. Nothing herein constitutes a binding obligation on Hexagon.

The information contained herein is subject to change without notice. 

© Copyright 2025 Hexagon AB and/or its subsidiaries and affiliates. All rights reserved.
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2 Installation

2 Installation
Quantum is available for download from the Veripos support site  https://help.veripos.com.

2.1 PC Minimum Requirements
The operating systems currently supported by Quantum are Windows 7 or later (64bit).

The minimum specifications for running Quantum software are:

Processor: i5 (2nd generation or later) @ 3.2GHz
Memory: 3 GB RAM
Hard disk: 250 GB
Serial ports: Optional for Tides data output and serial gyro input
Ethernet: 10/100 Mbps
Display: 17”,  1280 x 1024 minimum resolution
Peripherals: Mouse & keyboard
Operating system: Windows 7 or later (64-bit) 

Veripos can supply PC hardware with the correct specifications to ensure compatibility.

2.2 Software installation procedure
Detailed below is the procedure for installing Quantum software on a PC.

NOTE
Uninstall any other previous versions of Quantum that already exist on the PC prior 
to the installation of the latest version of Quantum. 

2.2.1 Installing Quantum on a PC
Double-click the Quantum installer file (the version number may differ from the example below):

Quantum installer file
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2 Installation

Running the installation files will launch the setup wizard. Click Next > to proceed with the installation:

Quantum Setup Wizard – Initial page

Please review and, if satisfied, agree to the license agreement, then click Next >:

‘License Agreement’ page
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2 Installation

Select the folder where you wish to install the Quantum software or leave the setting as the default 
directory and click Next >:

Installation directory

If desired, tick the Create Quantum Graphics Desktop Icon option, making it more straightforward to 
launch the software by using a desktop icon:

Additional installation options
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2 Installation

Quantum is now ready to install. Click Install to continue:

Ready to Install’ page

A confirmation will appear upon completion of installation. Select the two checkboxes based on 
preference and complete the installation by clicking Finish:

Quantum Setup Wizard – Completion

Users may launch Quantum via the desktop shortcut or the Windows Start Menu 
(Start > All Programs > Veripos > Quantum > Run Quantum).
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3.1 System Configuration

3 Settings
3.1 System Configuration
Users launching Quantum on a PC for the first time will need to create an initial configuration. The section 
Importing configurations covers the import of previous configurations. Note that users should only 
import configurations from version 6 or later.

3.1.1 Creating a new configuration
Quantum can locally save up to four separate configurations. To create a new configuration, click any of 
the four tiles as shown below:

'System Configuration’ page – First time run

3.1.2 Receiver configuration
Specify the Receiver Type and enter the Receiver IP address assigned to the unit. Clicking on any of the 
Receiver IP address fields will activate the on-screen keypad:

 

 

 

 

 

 

 

 

After entering details, click Next.
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3.1 System Configuration

The next page will list the Quantum licensing options currently associated with the active license or 
prompt the user to enter a new license as below:

 ‘New Configuration Licensing’ page

If a new Quantum licence code is required, contact Veripos Support for assistance. For further 
information regarding Quantum licence codes, please refer to the Quantum - Software licenses section.

Upon receiving a licence code from support, enter the code and click Next.

3.1.3 Save and launch configuration
Prior to saving, users must name the configuration. It is good practice to create an informative name for a 
configuration, such as the vessel name and the date or the name of a specific project:

‘Config Name’ page
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3.1 System Configuration

Users may then save the configuration by selecting either the Save & Launch or Save & Manage 
options. Save and Launch will start the configuration. Save and Manage will open the System 
Configuration menu, allowing for more changes,  if necessary, before the configuration launch:

 Save configuration options

3.1.4 Dashboard layout – First-time run
Upon starting a configuration, a user will be prompted by the display below, with options to choose either 
Load Preset Layout or Start with Blank Layout. Selecting the Load Preset Layout option will launch 
a predefined tile layout. Selecting Start with Blank Layout will require manual configuration of tiles:

Dashboard layout option
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3.1 System Configuration

3.1.5 System Configuration – After initial setup
Quantum provides both a day mode (default) and a night mode. A moon icon located at the top left of the 
screen allows for switching between the two. Note that this manual will use night mode for screen 
examples.

Quantum menu icon and day/night mode toggle

The System Configuration menu is available after the initial setup is complete. To access the Quantum 
System Configuration menu, select the menu (  ☰  ) icon located at the top left of the screen.

Select the Settings icon:

Quantum Settings icon

Selecting the Settings icon will present the Settings page.
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3.1 System Configuration

As shown below, basic system information is available on the Settings page (configuration name, unit ID, 
unit type, and IP address):

Settings main page – Quantum DP

Below the system information, the System Configuration menu item allows for Quantum configuration 
setup and editing:

System Configuration menu

Clicking on the above will reveal two Settings sub-sections (Quantum Management and Receiver 
Management) and display any (active and inactive) configurations that users can export, edit, or launch.

3.1.6 Exporting configurations
Upon creating a configuration, it is possible to export it to a file, providing the ability to back up 
configurations, which can be imported back into Quantum later if required.

From the System Configuration menu, click Export on the desired configuration:

Export configuration option (LD8)
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3.1 System Configuration

Choose a location to save the configuration file (e.g. PC hard drive or external USB storage), then select 
Export Configuration to save the configuration:

Save exported Quantum config file
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3.1 System Configuration

3.1.7 Importing configurations
To import a Quantum configuration, go to Settings > System Configuration and click Import 
Configuration:

Import Configuration option

Browse to the required Quantum file  and then click Import Configuration:

Import Configuration – Browsing to
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3.1 System Configuration

Upon display of the imported configuration, click Start to activate it:

Start imported configuration

3.1.8 Deleting configurations
To delete a Quantum configuration, go to Settings > System Configuration and click Delete:

Delete configuration
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3.1 System Configuration

A warning message will be displayed. Press OK to delete the configuration:

Delete configuration confirmation

NOTE
It is impossible to delete Active configurations.

3.1.9 Editing configurations
To edit a Quantum configuration, go to Settings > System Configuration and click Edit:

Edit configuration             

Edit allows changes to configuration parameters, e.g., the connection IP address or configuration name. 
After editing the configuration, select the Save & Launch or Save & Manage configuration option.

When editing the active configuration, select the Save & Launch option to apply any new settings.
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3.2 Quantum Management

3.2 Quantum Management
While in the System Configuration menu, clicking on System Configuration will allow access to the 
Quantum Management sub-menu:

Clicking Quantum Management provides the ability to configure Tides, Heading Display and PC Port 
Configuration.

The Quantum Management - Overview page will show Tides and Heading Display in one of three states:

Configuration carried out and applied

Not yet configured or not active

Not yet licensed, contact Veripos Support to license if required

To edit Quantum Management 
configurations, select Edit, 
located at the bottom right-
hand corner of the Quantum 
Management - Overview 
screen:       
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3.2 Quantum Management

Each menu is separated by tabs, with a highlighted background indicating which menu is presently 
selected. Upon clicking ENABLED, additional configuration options will appear.

3.2.1 Tides
Enabling Tides

Upon first access, Tides will be DISABLED, and no other options will be available. Toggling DISABLED 
to ENABLED will allow for the configuration of Tides options. Use Apply to save any changes made.

Tides configuration
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3.2 Quantum Management

Logging

This will display the Tides file save path, where both Sprint and Tidesinfo files are generated. Removing 
files from this location will restart the Doodson Tides calculation, but copying files will not impact it.

Settings > Antenna Height
Users can enter the Antenna height above the waterline (in metres) here. When using the Geoid Tide, 
this value is required to be updated regularly with vessel draft changes. MSS Tide does not use the 
antenna height.

Settings > Averaging Period
The averaging period is the interval time which calculates each tide value. This sliding scale allows for 
the specification of tide value calculation interval in minutes, from 1 to 60.

Settings > Geoid Model
This allows for the selection of Geoidal Model EGM96, EGM08 or USER, a change which will only apply 
to Geoid Tide. When selecting USER, the option to enter a Geoid separation value (metres) will appear. 
This Geoid Model selection is not applicable for any position output.

Output > Output Format
The system can output Tide information in two different formats TIDEINFO, or SPRINT. The details of 
these formats are available in the Reference information section.

By default,  the output format is DISABLED:

Tides output

Output > Output Format > TIDESINFO / SPRINT > Output Rate
Toggling Output Rate to either TIDEINFO or SPRINT will reveal the option to configure Output Rate, 
which users can toggle between ON CHANGE and 1HZ. ON CHANGE will only output one epoch at the 
end of the averaging period, whereas 1HZ will output an epoch every second with a new timestamp.

Output Rate

Output > Output Format > TIDEINFO / SPRINT > Output Type
The Tides output message can be outputted from the PC using TCP/IP and Serial. When users select 
either option (or both), additional configuration options will appear.

Output Type
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3.2 Quantum Management

Output > Output Format > TIDEINFO / SPRINT > Output Type > TCP/IP Port
When selecting TCP/IP, a port within the range of 9900-9999 should be specified:

TCP/IP Port

Output > Output Format > TIDEINFO / SPRINT > Output Type > SERIAL

When selecting the SERIAL output type, several additional options will appear:

Serial Port

Output > Output Format > TIDEINFO / SPRINT > Output Type > SERIAL > Serial Port

A sliding scale will allow the selection of the desired serial port from which to output.

Output > Output Format > TIDEINFO / SPRINT > Output Type > SERIAL > Baud Rate

Baud 1200, 2400, 4800, 9600, 19200, 38400, 57600 or 115200 is available.

Output > Output Format > TIDEINFO / SPRINT > Output Type > SERIAL > Protocol

Where available on rackmount solutions Protocol can be set to RS232 or RS422. 

Output > Output Format > TIDEINFO / SPRINT > Output Type > SERIAL > Stop Bits

The Stop Bits can be set to 1 or 2.

Output > Output Format > TIDEINFO / SPRINT > Output Type > SERIAL > Data Bits

The Data Bits can be set to 7 or 8. 

Output > Output Format > TIDEINFO / SPRINT > Output Type > SERIAL > Parity Bits

The Parity Bits can be set to NONE, ODD or EVEN.
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3.2 Quantum Management

Calculation

Users have the option to Restart Tides Calculation, which will reset the MSS Tides and require the 
system to accumulate 39 hours of data before the tides information becomes available. For Geoid Tides 
users, the tides information will be available immediately after the initial averaging period is completed.

CAUTION
MSS Tides will take 39 hours to initialise after a reset

3.2.2 Heading Display
Upon first access, the Heading Display will be DISABLED, and no options will be present. Toggling 
DISABLED to ENABLED will allow for the configuration of Heading Display options. Use Apply to save 
any changes made.

Heading Display > Source

When toggled to GNSS, no further configuration is necessary. Toggling to EXTERNAL will allow for an 
external source of NMEA format heading to be input to Quantum for display purposes, and it will also 
display additional options as detailed below:

NOTE
When GNSS Heading is the selected source, users must also enable Heading  in 
the LD8 or LD900 receiver

Heading Display > Offset

This option will appear when Heading Output is ENABLED, and users can set it to a value between -180° 
and 180°. This option allows for the application of an offset to the calculation. Any offset value entered in 
here will only change the heading display and won’t change the heading output.
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3.2 Quantum Management

Heading Display > Source > EXTERNAL > Input Type > TCP/IP

Toggling Input Type to TCP/IP will present additional configuration options:

TCP/IP configuration

Heading Display > Source > EXTERNAL > Input Type > TCP/IP > IP Address

Clicking within any of the fields will bring up the onscreen keyboard, allowing the input of an IP Address

Heading Display > Source > EXTERNAL > Input Type > TCP/IP > TCP

Allows the entry of a TCP/IP port number between 1-9999

Heading Display > Source > EXTERNAL > Input Type > SERIAL

Toggling Input Type to SERIAL will present additional configuration options as detailed below:

Heading Display - Serial configuration
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3.2 Quantum Management

Heading Display > Source > EXTERNAL > Input Type > SERIAL > Serial Port

Allows the selection of a PC Serial port.

Heading Display > Source > EXTERNAL > Input Type > SERIAL > Baud Rate

The baud rates available for selection are 1200, 2400, 4800, 9600, 19200, 38400, 57600 or 115200.

Heading Display > Source > EXTERNAL > Input Type > SERIAL > Protocol

Where available on rackmount solutions Protocol can be set to RS232 or RS422. 

Heading Display > Source > EXTERNAL > Input Type > SERIAL > Stop Bits

Allows the selection of 1 or 2 Stop Bits.

Heading Display > Source > EXTERNAL > Input Type > SERIAL > Bit Rate

Allows the selection of 7 or 8 Bitrate.

Heading Display > Source > EXTERNAL > Input Type > SERIAL > Parity Bits

Allows the selection of NONE, ODD or EVEN Parity Bits.

Heading Display > Source > EXTERNAL > Input Type > SERIAL > Offset

Allows the input of a display offset.
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3.2 Quantum Management

3.2.3 PC Port Configuration
Within PC Port Configuration, users can toggle available port functionality from NONE to BAM (Bridge 
Alert Management) or where connected to a  MOXA PC, ICOM BRIDGE.

3.2.3.1 BAM

BAM provides the ability to configure available PC Serial ports for bridge alert message transmission and 
reception with a Central Alert Management (CAM) system, using  proprietary Veripos (non-EC 61162-1 / 
NMEA 0183 compliant) ALC, ALF and ACN messages. 

A Cyclic Alert List (ALC) message sent every 30 seconds details current alerts and the detection of 
jamming or spoofing events triggers the transmission of an Alert (ALF) sentence. Alert Commands 
(ACN), sent from a CAM system to Quantum, will acknowledge receipt of or request retransmission of  
ALF sentences.

NOTE
BAM can only be configured on one port at a time and is unavailable on ports 
already used for Tides or Heading Display

PC Port Configuration > COM# / NMEA# > Function > BAM > Baud Rate

Baud 1200, 2400, 4800, 9600, 19200, 38400, 57600 or 115200 is available.

PC Port Configuration > COM# / NMEA# > Function > BAM > Stop Bits

Allows the selection of 1 or 2 Stop Bits.

PC Port Configuration > COM# / NMEA# > Function > BAM > Parity Bits

Allows the selection of NONE, ODD or EVEN Parity Bits.

PC Port Configuration > COM# / NMEA# > Function > BAM > Data Bits

Allows the selection of 7,  or 8 Data Bits.
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3.2 Quantum Management

3.2.3.2 ICOM BRIDGE

Rackmount MOXA PC Quantum installations bridge LD900 ICOM port 1-4 outputs to a MOXA PC's 
NMEA 1-4 ports. Upon configuration of the ICOM ports, as detailed below, the bridge will initialise.

NOTE
ICOM Bridging requires LAN1 to be on the same network as the MOXA PC.

The NMEA to ICOM BRIDGE correspondence is as follows:

NMEA1 - ICOM1 (TCP port 3001)
NMEA2 - ICOM2 (TCP port 3002)
NMEA3 - ICOM3 (TCP port 3003)
NMEA4 - ICOM4 (TCP port 3004)

NMEA ports are RS422 only, and the following format applies:    
NMEA TXA = TX-    
NMEA TXB = Tx+    
NMEA RX A = Rx-    
NMEA RXB = Rx+   

PC Port Configuration > COM# / NMEA# > Function > ICOM BRIDGE > Baud Rate

Baud 1200, 2400, 4800, 9600, 19200, 38400, 57600 or 115200 is available.

PC Port Configuration > COM# / NMEA# > Function > ICOM BRIDGE> Stop Bits

Allows the selection of 1 or 2 Stop Bits.

PC Port Configuration > COM# / NMEA# > Function > ICOM BRIDGE> Parity Bits

Allows the selection of NONE, ODD or EVEN Parity Bits.

PC Port Configuration > COM# / NMEA# > Function > ICOM BRIDGE> Data Bits

Allows the selection of 7,  or 8 Data Bits.
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3.3 Receiver Management

3.3 Receiver Management
Clicking on System Configuration will allow access to the Receiver Management - Overview sub-
menu, which provides an overview of the current receiver configuration. Clicking Edit will display the 
configurable options for the receiver.

Clicking Receiver Actions, located at the bottom-left of the Receiver Management page, will allow 
access to the receiver configurable options as detailed in the next section:
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3.3 Receiver Management

3.3.1 Receiver Actions 
Receiver actions provide the ability to factory reset and reboot the receiver or modify network settings:

Factory Reset

A factory reset will cause the receiver to revert to factory default settings, with the exception of IP 
Address. Users should only perform a factory reset under the advice of Veripos Support.

NOTE
To delete the all logged files please reference the FILEDELETE command found in 
the LD8 Installation and Operations Manual.

Reboot

Reboot reboots the unit, resets any active positioning, and causes active PPP solutions to re-converge.

Network

The Network option allows for both LAN configuration and also allows the receiver to use its GPS time to 
synchronise the clocks on other network equipment.

Network > IP Config (LD8) / Network > LAN1 (LD900)

CAUTION
Entering an incorrect IP address will cause Quantum to stop functioning.

Users can set the Mode to DISABLED, DHCP or STATIC, where the IP Address, Subnet Mask and 
Gateway IP must be defined. DNS is available as a configurable option if required:

Network > IP Config (LD8) Network > LAN1 (LD900)
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3.3 Receiver Management

Network (LD900) > LAN2

The LD900 MMI controls LAN2 network settings, and the information available here is for reference only.

    LAN2 configuration   

Network (LD900) > Wi-Fi

Wi-Fi options should be left DISABLED as the LD900 presently has no Wi-Fi functionality. 

    Wi-Fi settings   

Network > PTP

By default, PTP Mode is set to DISABLED. However, when toggling PTP Mode to ENABLED, the 
receiver can use GPS time to synchronise the clocks on other network equipment.

    Default PTP Mode (LD8 example)   

After toggling PTP Mode to ENABLED, additional Time Scale and Profile options will appear:

     PTP Mode toggled to Enabled (LD8 example)    

Users can toggle Time Scale between PTP format (default), which does not correct for leap seconds, or 
UTC format, which corrects for leap seconds and can set Profile to the default of UDP E2E (end to end), 
UDP P2P (peer to peer), ETH E2E (end to end), ETH P2P (peer to peer) or ITU-T. 
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3.3 Receiver Management

3.3.2 Receiver Management – Edit
Within the Receiver Management - Edit page component menus are tab separated, with a highlighted 
background indicating which menu tab is selected. As shown in the examples below, the tabs available 
will depend on authorised features and the product in use:

LD8 & LD900 Receiver Management, with authorised Heading

LD900 Receiver Management, with authorised INS (and) Heading

3.3.2.1 Position

PPP > GNSS1 Mode / GNSS2 Mode

Veripos APEX and Ultra PPP provide worldwide decimetre accuracy positioning with no range 
limitations. On systems with corrections subscriptions that include both Ultra and Apex, Veripos 
recommend that users   set Mode to AUTO to allow the receiver to select the solution with the best 
standard deviation automatically.

NOTE
Secondary Positioning is only available for Authorised LD900 systems.
    • The activation code applies to both primary and secondary solutions.
    • The secondary positioning mode does not support APEX Pro and will default to 
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3.3 Receiver Management

APEX5 when activated for APEX Pro.
    • The secondary positioning solution NMEA position output is limited to 1Hz and 
COM4 and COM5 only (ICOM ports are unavailable).
    • IALA, 3rd Party, and RTK corrections are unavailable for secondary positioning.

CAUTION
If using only Apex or Ultra corrections users should ensure that the Mode selected 
matches the service activated by the Helpdesk.

NMEA Config > NMEA DQI

When using either Apex or Ultra PPP services the NMEA DQI is a value reported within NMEA GGA 
messages to indicate a converged PPP solution status. This value can be toggled between either 2 or 5. 
When set to 2 and the system has corrections applied to the position, a 2 will be output. When set to 5 
and a PPP solution is fully converged the DQI value will be 5.

NMEA Config > NMEA Precision

It is possible to configure the number of decimal places used in the Latitude and Longitude fields output 
in the GGA Message. The precision can be set to 5, 6, 7 or 8.

NMEA Config > NMEA Talker

The ability to interface with legacy hardware is provided. The NMEA Talker can be toggled between Auto 
and GP.

TRINAV Config > Output Format

The ability to toggle TRINAV Output Format between V3 and V4 is provided.

TRINAV Config > NavPoint Number

The ability to enter a NavPoint Number is provided.

RAIM > RAIM Mode

Receiver autonomous integrity monitoring (RAIM) is a technology developed to assess the integrity of 
GNSS signals used by a GNSS receiver. RAIM uses redundant signals and a statistical function to 
determine if there are problems with the positioning solution; in simple terms, RAIM acts as an internal 
self-check. RAIM is enabled by default. Do not disable RAIM unless advised by Customer Support.

NOTE
The configuration parameters for NMEA Config and RAIM will be applied to both 
primary and secondary position solutions.
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3.3.2.2 GNSS

Receiver Management – GNSS (LD900 example)

GNSS Config > Tracking Elevation Mask

The Tracking Elevation Mask prevents GNSS satellites on or below a certain elevation from being 
tracked. Veripos recommends the default value of 10 degrees for optimal performance.

GNSS Config > Signal Tracking

CAUTION
Do not change the default signal tracking unless advised by Veripos Support.

NOTE
Users can not turn off constellations selected as the primary time source.

Specific GNSS constellations or particular constellation signals may be toggled On or Off.

GNSS Config > Time Source

Time Source allows users to specify GPS, BEIDOU, or GALILEO  as the primary timing source.

PPS Settings > PPS Control

The PPS functionality can be DISABLED and ENABLED. 

PPS Settings > PPS Polarity

The PPS Polarity can be switched between POSITIVE and NEGATIVE. 

PPS Settings > PPS Pulse Width (ms)

The PPS Pulse width (set in milliseconds) may be changed if required and is configurable within a range 
of 1 to 500 milliseconds.
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3.3.2.3 Corrections (LD8)

Receiver Management – Corrections (LD8 example)
RTK > Source

Users can receive RTK corrections in the RTCM v3 format by selecting AUTO for the Source. 

RTK – Source

VERIPOS > Mode

The Mode determines which L-band beam management options are available. Setting the Beam Mode 
to DISABLED will simulate the failure of corrections, which is useful in failure mode and effects (FMEA) 
testing. When using Mode AUTOMATIC, the receiver will track and use data from up to three beams 
simultaneously, with tracking determined based on the receiver location and the highest elevation 
beams.     Using Mode AUTOMATIC mitigates against the impact of a single beam loss. Additionally, 
selecting the most appropriate beam for any given location will not be required whilst transiting across 
multiple regions in this mode. 

AUTOMATIC beam selection

L-band > Mode > MANUAL

When tuning to MANUAL, users can choose an available beam or add a USER-defined beam.  Do not 
switch the Beam option to USER unless instructed to by Veripos support.

MANUAL beam selection
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NTRIP > Mode

This option allows the user to toggle between having NTRIP DISABLED or ENABLED. 

If enabled, the LD8 can receive Veripos RTCM corrections via NTRIP. An NTRIP service activation from 
Veripos Support is necessary for use, and the LD8 must also be connected directly to a network with 
external access to obtain Veripos NTRIP caster data.

CAUTION
NTRIP should only be enabled if included in the Veripos SAL. Please contact 
Veripos support to confirm if you are unsure.

To configure the LD8 to receive VERIPOS corrections via NTRIP, firstly use an internet-connected laptop 
on the same network as the LD8 and browse to the Veripos NTRIP caster http://sid-output.com:2101 to 
verify that connections via port 2101 are available. The browser should reply with four lines of structured 
binary data. No reply may suggest that port 2101 is blocked, which can be resolved by contacting local IT 
support. Upon establishing a successful connection NTRIP may be ENABLED.

NTRIP Mode

SBAS > SBAS Control

This option allows the user to switch SBAS correction fallback to DISABLED or AUTOMATIC. 

When the option AUTOMATIC is selected, fallback will be available in case of a Veripos solutions failure. 
When DISABLED, the solution will revert to uncorrected in case of a Veripos solutions failure. Use of the 
SBAS solution will only occur should Veripos solutions be unavailable.

SBAS – SBAS Control

NOTE
SBAS corrections are not available in all regions, additionally the SBAS service is 
not under the control of Veripos.
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3.3.2.4 Corrections (LD900)

Receiver Management – Corrections (LD900)

RTK > Source

The LD900 is capable of receiving RTK corrections. Enable RTK by selecting AUTO for the Source. 

RTK – Source

VERIPOS > LBAND / GNSS1 Antenna

Upon clicking the LBAND or GNSS1 Antenna settings cog, users can configure inputs for either Mode.  
Setting the Mode to DISABLED will simulate the failure of corrections, which is useful in failure mode and 
effects (FMEA) testing. When using the default of Mode AUTOMATIC, the receiver will track and use 
data from up to three beams simultaneously, with tracking determined based on the receiver location and 
the highest elevation beams. Using Mode AUTOMATIC can mitigate against the impact of a single beam 
failure or masking. Selection of the most appropriate beam for any given location will not be required 
whilst transiting across multiple regions in this mode.

LD900 LBAND Antenna Mode settings
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Selecting MANUAL will provide additional LBAND beam management options. An available Beam can 
be selected, or a USER-defined beam added.

Manual beam selection

The user may select  pre-configured Veripos beam frequency or switch to USER.

Switching the Beam option to USER will allow for the input of a USER beam. Do not use unless 
instructed to by Veripos support.

User Beam options

NTRIP > Mode

This option allows the user to toggle between having NTRIP DISABLED or ENABLED.

If enabled, the LD900 can receive Veripos RTCM corrections via NTRIP. An NTRIP service activation 
from Veripos Support is necessary for use, and the LD900 must also be connected directly via LAN1 to a 
network with external access to obtain Veripos NTRIP caster data.

CAUTION
NTRIP should only be enabled if it is included in the Veripos SAL. Please contact 
Veripos support to confirm if you are unsure.

To configure the LD900 to receive VERIPOS corrections via NTRIP, firstly use an internet-connected 
laptop on the same network as the LD900 and browse to the Veripos NTRIP caster 
http://sid-output.com:2101 to verify that connections via port 2101 are available. The browser should 
reply with four lines of structured binary data. No reply may suggest that port 2101 is blocked, which can 
be resolved by contacting local IT support. Upon establishing a connection NTRIP may be ENABLED.

NTRIP Mode
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MF > Source

The MF Source setting can be toggled between ENABLED and DISABLED, defaulting to ENABLED.

NOTE
The MF option will only be available on Quantum if MF is available for the LD900.

MF > Receiver Mode

Receiver Mode can be set to either AUTOMATIC or MANUAL. AUTOMATIC will cause the MF receiver 
to lock onto the highest quality MF signal detected. MANUAL will require an MF station Frequency(kHz) 
to be entered, restricted to the range of 283.5 to 325.0 kHz:

SBAS > SBAS Control

This option allows the user to switch SBAS correction fallback to DISABLED or AUTOMATIC. When the 
option AUTOMATIC is selected, fallback will be available in case of a Veripos solutions failure. When 
DISABLED, the solution will revert to uncorrected in case of a Veripos solutions failure. Use of the SBAS 
solution will only occur should Veripos solutions be unavailable.

SBAS – SBAS Control

NOTE
SBAS corrections are not available in all regions, additionally the SBAS service is 
not under the control of Veripos.
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3.3.2.5 Heading (LD8)

Heading configuration (LD8)

Heading Output (LD8) > Offset

Will appear all times. It can be set to a value between -180° and 180°. This option allows for an offset to 
be applied to the calculation. Any offset value entered in here will be applied to Heading outputs from the 
GNSS receiver.
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3.3.2.6 Heading (LD900)

Heading configuration (LD900)

If licensed, the LD900 can be used to compute heading. However, if the applied Quantum license does 
not support heading, then Quantum will not display this item. Quantum can also input Heading from an 
external source via Serial or TCP/IP.

Heading Output (LD900)

This option toggles whether a heading output is available.

Heading Output (LD900) > Offset

Will appear when Heading Output is ENABLED. It can be set to a value between -180° and 180°. This 
option allows for an offset to be applied to the calculation. Any offset value entered in here will be applied 
to Heading outputs from the GNSS receiver.
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3.3.2.7 INS (LD900)

INS configuration (LD900)

Where licensed, LD900 and LD900M model receivers interfaced to an appropriate IMU will be capable of 
INS.

Enabling INS

Toggling INS to ENABLED will allow for configuration of INS options. Use Apply to save any changes 
made.

IMU > Type

The two INS IMUs supported for use within Quantum are the ISA-100C and the μIMU-IC.

IMU > Port

The LD900 COM port which the IMU is being interfaced on (COM1, COM2 or COM3) can be selected 
here.

IMU > IMU Installation > Rotational Offset

This field allows the user to enter Rotational Offset X, Y and Z values within a -180.00° to +180.00° 
range.

IMU > IMU Installation > IMU to Antenna Offset 

This field allows the user to enter Primary (GNSS1) Antenna Translational Offset X, Y and Z values.
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IMU > IMU Installation > IMU to User Reference Point

The User Reference Point represents a user-defined point or location, set separately from the INS and 
Antenna Reference Points. This reference point is not inherently part of the system's internal calculations 
but is rather a user-defined offset or adjustment applied to the INS-derived position or to align with 
specific user requirements.

By specifying X, Y, and Z value adjustments to shift the calculated position users may align the User 
Reference Point with external references.

IMU > IMU Installation >Heave Filter Period

The Heave addresses heave motion (vertical movement of vessel in response to waves or other 
disturbances) and represents the duration of time which the filter analyses and adjusts for vertical 
displacement variations of the vessel. A shorter filter period might provide more frequent updates but 
may be susceptible to noise, while a longer filter period may smooth out the data but could introduce a 
delay in responding to changes in heave motion.

The time entered in seconds will determine how quickly the INS can adapt to changes in the vertical 
motion of the platform while maintaining accuracy and stability.

With an understanding of the trade-offs between responsiveness and noise filtering Users may adjust the 
Heave Filter period based on operational scenario requirements.
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3.3.2.8 I/O Serial

I/O Serial configuration (LD900 example)

Serial ports can output active calculation data or input correction data from an external source.

COM#
Select the COM port that requires setting up.  Both the LD8 and LD900 COMs 1-3 support baud between 
1200 and 460800, set to a default baud of 9600.

CAUTION
While official NMEA 0183 Standard specifies 4800 as the default baud for most 
communication, it is recommended to use 9600 bits per second and above. Lower 
baud, such  2400, should generally be avoided, as the reduced data transmission 
speed may result in delayed or missed updates, particularly in systems requiring 
frequent position or heading data.

The LD900 additionally includes the following:

Without the use of a 3-port Aux cable on DB15HD connector on COM4 Aux Port:
 l COM4, supporting 9600 to 460800 baud.

With the use of the 3-port Aux cable on DB15HD connector:
 l COM4, supporting 9600 to 460800 baud.
 l COM5, supporting 9600 to 460800 baud for the output of secondary positioning.
 l COM6,  supporting a fixed baud of 38400 for correctional inputs (RTK, IOLAN, UHF).

COM# > Type
The COM communication type options are NONE, OUTPUT, or INPUT. When selecting NONE, all inputs 
and outputs for that port will cease. When selecting either OUTPUT or INPUT further configuration 
options will appear.
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COM# > Type > Output
Selecting OUTPUT will allow for selection of NMEA (GGA, GSA, GSV, GST, VTG, RMC, GLL, GRS, 
ZDA, HDT* INHDT**, and PASHR**), UKOOA, TRINAV (V3 or V4 as configured in Position), VERIPOS 
(Veripos corrections), INS** (TSS1, HEAVE, INSPVA,  INSSTDEV, SYNCHEAVE and 
DELAYEDHEAVE) and OTHERS (BESTPOS, BESTGPSPOS) message data outputs.

*Requires heading to be enabled and licensed.   
**Requires INS to be licensed and enabled

Type - Output

COM# > Type > Input
Selecting INPUT will allow for the input of external VERIPOS corrections, RTCMV2 (3rd party DGNSS 
RTCM v2 corrections), RTCMV3 (3rd party RTK or DGNSS RTCM v3 corrections), CMR (RTK correction 
data), IOLAN (NTRIP serial connections) or NOVATELX (NovAtel format corrections).

Type – Input (Veripos example)
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Baud Rate

Baud 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200, 230400 and 460800 is available.

CAUTION
While official NMEA 0183 Standard specifies 4800 as the default baud for most 
communication, it is recommended to use 9600 bits per second and above. Lower 
baud, such  2400, should generally be avoided, as the reduced data transmission 
speed may result in delayed or missed updates, particularly in systems requiring 
frequent position or heading data.

Select an appropriate baud for the required bandwidth of message type output:

Protocol
Users may set Protocol to RS232 or RS422. Options differ between the LD8 and LD900, use the below 
table as a reference:

 COM1 & COM2 COM3 COM4 COM5 COM6
LD8 RS232 / RS422 RS232 -- -- --

LD900 RS232 / RS422 RS232 / RS422 RS232* / RS422* RS232* / RS422* RS232** / RS422**
*Output only     **Input only

Stop Bits
Users may set Stop Bits  to 1 or 2.

Data Bits

Users may set Data Bits  to 7 or 8.

Parity Bits
Users may set Parity Bits to NONE, ODD or EVEN.

NMEA Output Rate
Except for LD900 COM4 and COM5, which are restricted to 1Hz, when selecting NMEA data outputs (the 
number of NMEA outputs within 1 second), rates of  1, 2, 5, 10 and 20 Hz are available. If selecting INS 
data outputs on LD900 units, rates of 1, 2, 5, 10, 20, 50, 100 and 200 Hz are available.
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3.3.2.9 I/O Network

Receiver Management – I/O Network (LD900)

For the LD8, five TCP/IP ports are available, ICOM1 (3001), ICOM2 (3002), ICOM3 (3003), ICOM4 
(3004) and ICOM5 (3005).

For the LD900, either seven TCP/IP ports will be available, ICOM1 (3001), ICOM2 (3002), ICOM3 
(3003), ICOM4 (3004), ICOM5 (3005), ICOM6 (3006) & ICOM7 (3007), or a MOXA tab will appear (see 
next section).

Each port can be configured to output active calculation data.

ICOM# > Type
        The I/O Network port options are NONE, OUTPUT, or INPUT. When selecting NONE, all inputs and 
outputs for that port will cease. When selecting either OUTPUT or INPUT further configuration options 
will appear.
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ICOM# > Type > Output

Selecting OUTPUT will allow for selection of NMEA (GGA, GSA, GSV, GST, VTG, RMC, GLL, GRS, 
ZDA, HDT*, INHDT**, and PASHR**), UKOOA, TRINAV(V3 or V4 as configured in Position), VERIPOS 
(Veripos corrections) and INS**  (TSS1, HEAVE, INSPVA,  INSSTDEV, SYNCHEAVE and 
DELAYEDHEAVE), DATA LOGGER and OTHERS (BESTPOS, BESTGPSPOS) message data 
outputs.

*Requires heading to be enabled and licensed.   
**Requires INS to be licensed and enabled

Type - Output   

ICOM# > Type > Input

Selecting INPUT will allow for the input of external VERIPOS corrections, RTCMV2 (3rd party DGNSS 
RTCM v2 corrections), RTCMV3 (3rd party RTK or DGNSS RTCM v3 corrections), CMR (RTK correction 
data), IOLAN (NTRIP serial connections) or NOVATELX (NovAtel format corrections).

Protocol

The LD900 can output and input TCP and UDP protocol on all I/O Network ports.

End Point Address

Selecting  TCP will allow for the entry of an end-point address between 0.0.0.0 and 255.255.255.255.

Port

When using either TCP or UDP protocol the port number can be set within a range of 1 – 65535.

NMEA Output Rate

When selecting NMEA data outputs (number of NMEA outputs within 1 second)  rates of  1, 2, 5, 10 and 
20 Hz are available. If selecting INS data outputs on LD900 units, rates of 1, 2, 5, 10, 20, 50, 100 and 200 
Hz are available.
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3.3.2.10 MOXA (LD900) 

Where required an optional Moxa serial port expansion unit can be used to convert ICOM to serial. If this 
has been interfaced, then a MOXA tab will be available within the Receiver Management page.

Select P1, P2, P3, P4, P5, P6 or P7, depending on which port requires setting up.

NOTE
The settings of P7 will be duplicated to P8.

P# > Type

The intended COM communication type will be either NONE, OUTPUT or INPUT. When selecting NONE 
all input and outputs for that port will cease. When selecting either OUTPUT or INPUT further 
configuration options will appear.

 

P# > Type > Output

Selecting OUTPUT will allow for selection of NMEA (GGA, GSA, GSV, GST, VTG, RMC, GLL, GRS, 
ZDA, HDT* and PASHR**), UKOOA, TRINAV (V3 or V4 as configured in Position), VERIPOS (Veripos 
corrections) and INS**  (TSS1, HEAVE, INSPVA,  INSSTDEV, SYNCHEAVE and DELAYEDHEAVE) 
message data outputs.

*Requires heading to be enabled and licensed.   
**Requires INS to be licensed and enabled
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P# > Type > Input

Selecting INPUT will allow for the input of VERIPOS corrections, RTCMV2 (3rd party DGNSS RTCM v2 
corrections), RTCMV3 (3rd party RTK or DGNSS RTCM v3 corrections) or CMR.

 

Baud Rate

Baud 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200, 230400 and 460800 is available.

CAUTION
While official NMEA 0183 Standard specifies 4800 as the default baud for most 
communication, it is recommended to use 9600 bits per second and above. Lower 
baud, such  2400, should generally be avoided, as the reduced data transmission 
speed may result in delayed or missed updates, particularly in systems requiring 
frequent position or heading data.

Select an appropriate baud for the required bandwidth of message type output:

Protocol

The LD900 can input and output RS422 and RS232 protocol on P1-P7.

Stop Bits

Stop Bits can be set to 1 or 2.

Data Bits

Data Bits can be set to 7 or 8.

Parity Bits

Parity Bits can be set to NONE, ODD or EVEN.

NMEA Output Rate

When selecting NMEA data outputs (number of NMEA outputs within 1 second)  rates of  1, 2, 5, 10 and 
20 Hz are available. If selecting INS data outputs on LD900 units, rates of 1, 2, 5, 10, 20, 50, 100 and 200 
Hz are available.
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3.3.2.11 GRIT

The GRIT tab allows for the enabling of Spoofing Detection and Interference Detection.

NOTE
When licensed for Interference Mitigation the option to configure filters will become 
available via the Spectrum view.

Spoofing

Upon first access, Spoofing will be DISABLED. Toggling DISABLED to ENABLED will display Spoofing 
Detection on the Quantum screen.

Calibration Status

This non-configurable field will appear when Spoofing is ENABLED, highlighting the Spoofing 
Calibration Status.
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Start Calibration / Restart Calibration

If the Calibration Status is not PASSED, an option to Restart Calibration is available. Clicking this option 
will result in the display of the below dialog:

Upon clicking OK, calibration of Spoofing Detection will commence. This process will take a few minutes, 
do not power off the receiver until the process is complete. Once complete, the GNSS card will 
reboot.

CAUTION
The calibration of spoofing detection will restart the PPP calculation. PPP 
convergence will require time; during this time, a Standard/Standard2 solution will 
be output from the receiver until the PPP solution becomes available.

Interference

Upon first access, Interference will be DISABLED. Toggling DISABLED to ENABLED will display 
Interference Detection on the Quantum screen.

Use Apply to save any changes made.

56Quantum User Manual



3.3 Receiver Management

3.3.2.12 Antenna Voltage (LD8)

The Antenna Voltage tab allows for toggling of  antenna voltages between On or Off:

Receiver Management - Antenna Voltage (LD8)

CAUTION
Turning off the voltage may stop the antenna receiving power and result in a loss of 
signal reception. The voltage should only be turned off when signals are received 
through a RF splitter with another power source.

3.3.2.13 Antenna Voltage (LD900)

The Antenna Voltage tab allows for toggling of  antenna voltages between On or Off:

Receiver Management - Antenna Voltage (LD900)

CAUTION
Turning off the voltage may stop the antenna receiving power and result in a loss of 
signal reception. The voltage should only be turned off when signals are received 
through a RF splitter with another power source.
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3.4 System Status
The System Status menu displays information relating to the Quantum configuration, such as details of 
the connected Veripos receiver and the Quantum software version.

 General

Displays the name of the active Quantum Configuration:

System Status - Active Configuration name

58Quantum User Manual



3.4 System Status

Receiver

IP Shows IP address of the connected Veripos receiver.
Serial Number Displays unit ID of the connected Veripos receiver.
System Version Displays System Version of the connected Veripos receiver.
GNSS Card Details Displays GNSS card model information (not applicable for LD900)

System Status – Receiver

Software

Displays Quantum software version numbers (your version may differ):

System Status – Software

Performance

Displays system resource information. The scroll down arrow can be used to slide the bar to view the 
performance menu:

Performance information

Launch Engineering View

This option provides advanced information on L-band and GNSS signal tracking. Veripos may request 
information from the Engineering view during support cases. It is recommended to only use this view 
when under instruction from Veripos:

Engineering View
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3.5 Authorisations
The Authorisations menu displays information relating to system licencing.

Authorisations (LD900 example)

3.5.1 Receiver
Signal licenses

Quantum displays signal licence information relating to the type of correction service that is enabled on 
the interfaced Veripos IMU. This license information is not the Quantum software license.

Information on the three type of available Veripos solution (Apex, Ultra and Standard) is displayed. Each 
solution indicates which GNSS constellation is subscribed.

In the example below, the Veripos receiver has been enabled for the Apex5 service, which uses four 
GNSS constellations. GPS and GLONASS appearing next to Ultra and Standard indicates that the 
receiver has the backup services of Ultra² and Standard².

Signal Licences information
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GNSS Receiver licenses

This section displays which GNSS constellations and frequencies the GNSS receiver has the capability 
to track.

GNSS Receiver Licences information

3.5.1.1 GNSS1 / GNSS2 / L-band (LD900)

This section displays the PSN and Model of the GNSS 1, GNSS 2 and L-band receivers.

To purchase additional receiver functionality, e-mail the serial number of the LD900 system to your 
Veripos account manager. When requesting GNSS 2 secondary positioning, include the GNSS 2 PSN 
serial. Upon receipt of an authorisation code, apply this to the correct receiver by clicking the 
corresponding Apply New Authcode button:

• Apply Heading upgrades within the GNSS 1 section.
• Apply INS upgrades within the GNSS 1 section.
• Apply Secondary Positioning upgrades within the GNSS 2 section.

GNSS Receiver Licences information

NOTE
Authcodes may take up to ten minutes to apply and require a receiver reboot.
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3.5.2 Quantum
Software licenses

A Quantum software license is required. This is normally entered during the initial configuration process. 
The Software Licenses section displays the active Quantum license code and the enabled features of the 
license. Licenses can either be purchased (no expiry) or rented. Rented licenses have an expiry date and 
will need to be renewed.

The following modes are currently available:

 • DP Enables Quantum optimised for DP operations
 • Survey Enables Quantum optimised for Survey operations

The following features are currently available:

 • Heading Enables the use of heading functionality
 • Tides Enables the use of Tides functionality
 • INS Enables the use of INS functionality
 • Interference Mitigation Enables interference mitigation technology functionality

When requesting a new or revised software license, it is important to ensure that the appropriate features 
are requested.

A new Software licence code can be applied by clicking Apply New License, then entering the supplied 
license code and finally clicking Apply:

Software licence details – Purchased license
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Apply New Licence

If a license is rented, the rental expiry date of the Quantum software license will be shown below the list 
of enabled features:

Software licence details – Rented license

 

It is possible to have a combination of purchased and rented licenses. For example, the main Quantum 
license (DP or Survey) is purchased and an additional feature such as Heading could be rented. In this 
scenario, a license expired notification will appear periodically. If the expired feature is required a new 
license can be obtained by contacting Veripos Support. If a feature is no longer required, the expired 
feature can be cleared by clicking Acknowledge. This will prevent the notification from appearing and it 
will remove the expired feature from the Software Licenses section.

Software licence details – Rental Acknowledge
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3.5.2.1 Expired Licenses

If a rental license has expired, the notification message shown below will be displayed at regular 
intervals. Contact Veripos Support to obtain a new license:

License Expired notification
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3.6 Display
The Display settings page allows display setting changes.

3.6.1 General

3.6.1.1 Latency Indicator Direction

The Latency Indicator Direction setting controls the timeout graphic used to display corrections 
Latency:

Latency Indicator Direction setting
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By default, this is set to Down. When set to Down, the correction latency bars will count down from the 
maximum correction age (360 seconds for PPP, 120 seconds for DGNSS solutions):

PPP Correction Latency – Counting down

DGNSS Correction Latency – Counting down

To change the Latency Indicator Direction, click UP followed by Apply.

Once Apply is selected a momentary message: Changes Successfully Applied will appear.

When set as UP the correction latency bars will count up from zero:

PPP Correction Latency – Counting up
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DGNSS Correction Latency – Counting up

For further details regarding the Correction Latency view, refer to section Correction Link Satellites.

3.6.1.2 Latency Pulse Speed

The Latency Pulse Speed setting defines how fast or slow the Correction Age and Solution Status 
icons will pulse, ranging from 0 and 1 seconds (0.2 increments). A setting of 0 will disable the pulsing. It is 
recommended to leave the icons pulsating as this will show that the Quantum system is active:

Latency Pulse Speed setting

3.6.1.3 Full Screen

Quantum does not launch in full screen by default; however a full screen view can be enabled:

Latency Pulse Speed setting
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3.6.2 Heading Display
Heading display settings are only visible when the system is licensed and configured for Heading.

DP/Survey:

The Heading display page allows users to change Track Plot, SOG, COG and Tracking display settings:

Heading Tiles configuration

3.6.2.1 CoG and Tracking Display

Defines the minimum vessel velocity at which the CoG marker and track plot will update. This threshold 
velocity should be defined to suit the vessel dynamics.

CoG and Tracking Display setting

3.6.2.2 Speed Over Ground Units

Choose the units which vessel speed is displayed in. Choose between KNOTS, M/S or KM/H.

Speed Over Ground Units setting
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3.6 Display

3.6.2.3 Tracking

Tracking settings are used to change the style of the vessel track plot within the Heading view.

Heading view with track plot displayed
 

3.6.2.4 Track Plot

Choose if a track plot is to be DISABLED or ENABLED. Fields relevant to track plot will be shown once 
track plot is enabled.

Track Plot setting
 

3.6.2.5 Track Plot Point Type

Choose the type of track plot point symbol to be displayed (either an Arrow or Circle).

Track Plot Point Type setting
 

3.6.2.6 Track Plot Line

The vessel track plot can be configured as isolated points or interconnected with lines.

Track Plot Line Type setting
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3.6.2.7 Number of track points to display

Defines the number of historical track points to be displayed.

Number of track points to display setting

3.6.2.8 Track Plot Frequency

Defines the interval (and therefore frequency) at which points will be plotted. A high track plot frequency 
value may result in the display becoming cluttered. Clutter can be reduced by decreasing the track plot 
frequency (increasing the interval).

Track plot frequency setting

3.6.2.9 Track Plot Transparency

Defines the transparency of vessel track plots. The maximum transparency value is 80%.

Track plot transparency setting

3.6.3 Vessel Display
DP/Survey:

The Vessel Display page allows users to change colour and type of vessel.

Vessel Display settings for DP/Survey
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3.6 Display

3.6.3.1 Colour

This option allows users to select colour of vessel graphic to be displayed on the Heading and navigation 
plot tiles. The default colour of the vessel graphic is grey.

 

Vessel colour 

3.6.3.2 Type

Type allows Survey users to select the vessel type, Ship or Rig:

Vessel Type for Survey/DP
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3.7 Notifications

3.7 Notifications
Quantum can log significant events as notifications, these logs can be DISABLED or ENABLED 
(recommended).

For more detailed information on Quantum notifications, please refer to section Display Tabs.

72Quantum User Manual



3.8 Screensaver

3.8 Screensaver
Quantum has a screensaver feature (enabled by default) which is displayed after a defined period of user 
inactivity. The settings detailed below alter the screensaver behaviour.

3.8.1 Screensaver
Configures the screensaver feature to be DISABLED or ENABLED:

Screensaver setting
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3.8 Screensaver

3.8.2 Screensaver Transparent
By default, when the screensaver is ENABLED, the main display is not visible because the screensaver 
is not transparent:

Screensaver Transparent setting

 

It is possible to make the screensaver transparent so that the main Quantum screen is visible behind the 
screensaver:

Screensaver - Transparent disabled Screensaver - Transparent enabled

3.8.3 Screensaver Wait Time
Used to define when the screensaver will be launched after a period of no user interaction or system 
events. The default is 30 seconds:

Screensaver Wait Time setting

3.8.4 Screensaver Logo
Choose if the Veripos target logo is to be included on the screensaver. The default setting is DISABLED.

Screensaver Logo setting
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3.8 Screensaver

Screensaver Logo Enabled  

Screensaver Logo Disabled

3.8.5 Screensaver Animation
Defines if animation is used when the screensaver appears or clears. Choose between DISABLED and 
FADE. The default setting is DISABLED:

Screensaver Animation setting

3.8.6 Preview Screensaver
Click Preview Screensaver to immediately display the screensaver. This is useful for checking the 
screensaver appearance following setting changes:

Preview Screensaver option
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3.9 Close Quantum

3.9 Close Quantum
To close the Quantum software, click Close Quantum on the Settings page, as highlighted in blue 
below. Users should avoid clicking the 'X' in the Windows top panel, as highlighted in orange:

Close Quantum

After clicking Close Quantum, a confirmation message will appear, Click Yes to close Quantum:

Close Quantum confirmation

NOTE
Closing Quantum will not stop the NMEA or UKOOA position outputs that originate 
from the Veripos receiver.
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4 Screen overview

4 Screen overview
When Quantum has been launched and System Configuration has been completed (as detailed in 
section System Configuration), the Quantum screen should appear as below:

Quantum screen layout

The main elements of the Quantum screen are:

 l Sidebar
 l Menu icon
 l Display tabs
 l Notifications tab
 l Main display screen

4.1 Sidebar
The Quantum Sidebar, as seen on the left of the above Quantum screen layout image, displays overall 
status information for the active solution. The general health of the backup solution is also indicated by 
the colour and ‘pulse’ of the circular icon.

NOTE
The data displayed within the sidebar is not configurable.

4.1.1 Version number
Just above the Sidebar, the present version of Quantum in use can be found:
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4.1.2 Solution status
The name of the solution currently in use (active solution) will be displayed e.g. APEX. A pulsing circular 
icon is also displayed which is used to show general solution health.

A green pulsing circle indicates that the active solution is working within expected parameters with no 
issues. If there are any issues with the active solution, the colour of the solution status symbol will 
change.

An amber symbol indicates that the active solution is still working, but with some issues e.g. the 
correction age may be higher than expected.

A red symbol indicates that there is a critical problem with the active solution and positioning e.g. Loss of 
GNSS or the correction age has exceeded the allowable limit.

A turning blue circular (partial) trail indicates that a solution is converging (and therefore not available):

 

Solution Status – Healthy Solution Status – Warning

Solution Status – Failed Solution Status – Converging

Solution Status – PPP Converged & INS Aligning
Solution Status – Blended GNSS / INS

 

Solution Status - GNSS Lost & Dead Reckoning
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4.1.3 Satellite constellation
The Sidebar shows how many satellites from each relevant constellation are being tracked and how 
many are being used.

It is normal to see less satellites being used compared to the amount tracked. This is normal because 
some satellites are:

• Below the defined solution elevation mask

• Below the acceptable signal level mask.

• Not corrected.

Only GNSS constellations and satellites displayed in green are in-use by the active solution:

Sidebar – Satellite Constellation Status

4.1.4 Solution position and height
The Sidebar displays the WGS84 Latitude, Longitude and ellipsoidal height of the active solution which is 
being provided by the Veripos receiver.

Latitude and Longitude are displayed in DD:MM:SS.SSS format. Height is displayed in metres to 2 
decimal places:

Sidebar – Position & Heading
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4.1.5 HDOP, 2d-SD and V-SD
The Horizontal Dilution of Precision (HDOP) value is a measure of the quality of satellite horizontal 
geometry. A low satellite count typically leads to high HDOP values. Persistently high HDOP values may 
indicate issues with antenna obstructions or interference. The HDOP value is color-coded as follows:

 l Green: Healthy HDOP (< 2.0)
 l Amber: Moderate HDOP (2.0 to 4.0)
 l Red: Poor HDOP (> 4.0)

The Standard Deviation (2d-SD) value, expressed at a 95% confidence level, indicates the 2D 
accuracy of the active solution in meters. A smaller 2d-SD value corresponds to better solution accuracy.

The Vertical Standard Deviation (V-SD), similar to 2d-SD, is expressed at a 95% confidence level and 
indicates the vertical accuracy of the active solution in meters. A smaller V-SD value corresponds to 
better vertical solution accuracy. 

Sidebar – HDOP, 2d-SD and V-SD

4.1.6 Interference
Upon enabling Interference Detection, an Interference indicator will appear, which will illuminate amber 
upon detection of interference within the L1, L2 or L5 signal bands. If Quantum detects targeted 
jamming, this will change to a red-illuminated Jamming indicator:

Sidebar - Interference detected Sidebar - Jamming detected

See the Interference Status tile for frequency information or the RF Spectrum tile to help determine 
where the inference centre frequency lies in MHz.

4.1.7 Spoofing
Upon enabling Spoofing Detection, a Spoofing indicator will appear. The possible Spoofing indicator 
states are: 
        • Grey - Disabled
        • Amber - Amber - Enabled but not calibrated
        • Green - No spoofing detected.
        • Red - Spoofing detected.
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4.1.8 Backup solution
In most circumstances, there will be a backup solution in addition to the active solution. The Quantum 
sidebar displays the name and status of the backup solution.

Backup solutions are typically secondary PPP solutions or a Standard  solution. However, if no other 
backup solutions are available a backup solution may be an uncorrected position. In the event that only 
an uncorrected position (stand-alone position) is the backup, the sidebar will display an amber border.

4.1.9 Tides solution
The Tides Solution panel is displayed below the sidebar and indicates the Tides status. This solution 
panel is not displayed unless the Quantum Tides feature is activated. See Software licenses for details.

Sidebar – Tides status

4.2 Main Display Screen
The “Main Display Screen” consists of configurable view tiles. Full details options see section Display 
configuration.

4.3 Date and time
The date and time displayed below the Veripos Logo is received from the connected Veripos receiver. 
Time is displayed in UTC:

Veripos logo, date and time

4.4 Menu icon
The Menu icon is used to access all Quantum configurations, ranging from initial setup to view 
configuration.

4.5 Display Tabs
Display Tabs allow users to setup configurable views. Multiple display tabs can be configured 
(maximum of 4). For further details please refer to section Display configuration.

4.6 Notification Tab
The Notifications Tab is used to notify users of any significant systems events. The tab will show a icon 
with the number of current system notifications:
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4 Screen overview

Notification count

4.6.1 Viewing notifications
Click the Notification tab to display the list of system notifications. Notifications are split into two 
categories – Status and Status History:

Current and Historical Status list

Events, such as system error states which are currently active, will be displayed in the Status section. 
These could relate to loss of GNSS, loss of corrections data or poor GNSS quality which all would impact 
system performance:

Example of a current event notification

Historical Status notifications generally require no user intervention. These are usually events such as L-
band beam changes. Notifications raised in the Status section will move to the Historical Status section 
once the event is resolved (e.g. system error):

Example of Historical Status notification
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4 Screen overview

To view full details of a notification, click on the desired notification. If there is an issue with the system, 
the event description often contains useful troubleshooting guidance:

Full notification summary
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4 Screen overview

4.7 Screensaver
Quantum has an optional screensaver which provides an overall system status and displays a system 
label. This is defined on the top of the Quantum screen and is useful for monitoring the status of the 
software at a distance from the monitor. If critical issues arise the screensaver will cease.

Refer to section Screensaver for more information on screensaver configuration:

Screensaver clears when critical alarm present

Green pulsing circles on the screensaver are used to indicate that the active solution and backup solution 
are healthy:

Screensaver solution status indicator – Healthy

The screensaver will remain active during amber events, such as high correction age. During such 
Amber events the relevant solution will be displayed in amber. An example is shown below:

Screensaver solution status indicator – Amber
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5 Display configuration

5 Display configuration
5.1 Tab configuration
Quantum allows a maximum of four view tabs:

View tabs can consist of either preset tile layouts or tile layouts containing manually selected views.

5.1.1 Preset tile layouts
There are three predefined layouts:

• Default

• Heading (only present when authorised for Heading)

• GRIT

To select a preset tile layout, click the Menu icon (☰ ) followed by the large ‘+’ icon. Select the page 
layout icon:
 
 

 

 
Available preset tile layouts will display:

Accessing preset layout options

85Quantum User Manual



5 Display configuration

Click on the desired view. This selected view will now be displayed and the tab for this view will display 
the preset layout name e.g. Default:

Default tab example

5.1.1.1 Default tile layout

The Default tile layout consists of the following views:

 l Satellite Polar Plot
 l Solution Difference
 l Correction Link Status
 l Correction Link Signal Strength
 l Correction Age
 l Correction Link Signal Strength – Time Series

5.1.1.2 Heading tile layout

The Heading tile layout consists of the following views:

 l Heading
 l Heading Data
 l Correction Link Status
 l Correction Link Signal Strength
 l Correction Age
 l Correction Link Signal Strength – Time Series

5.1.1.3 GRIT tile layout

The GRIT tile layout consists of the following views:

 l Interference Status
 l Spoofing Status
 l Solution DOP
 l Correction Link Signal Strength
 l GNSS Signal Level
 l 2d-SD – Time Series
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5.2 User-configurable tile layouts
In addition to preset tile layouts, users can also select specific views to display by clicking on the ‘+’ sign 
next to the notifications icon:

Open new tab icon

The user can choose from one of the four available tile layouts, with arrows providing the ability to scroll 
through the available tile layouts:

Select tile layout option

The available tile layouts are shown below:

   

Available tile layouts

Click on the desired view and the new tab will then appear in Quantum with the chosen tile layout. The 
tiles will be empty so that the user can manually select which information is displayed within each tile.
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NOTE
The size of the tile dictates which information can be displayed in each. For      
example, the 2d-SD – Time Series view can only be displayed within a 2x1 sized      
tile.   

5.2.1 Renaming tabs
Any opened display tabs can be renamed. Tiles, which have been manually configured by the user, will 
be named New by default. It is recommended to rename these so that it is easy to identify which views 
each tab contains. For example, if a tab has views which relate to the L-band correction status the tab 
could be named ‘LBAND’. Preset tile layout tabs can also be renamed.

To rename a tab, double-click the tab where the current name is displayed, an on-screen keyboard will 
appear. Type the new name and press Enter to confirm:

On-screen keyboard for renaming tabs

NOTE
Tab names are restricted to a maximum of twelve characters and special 
characters      are not permitted.   

The new name will now appear within the tab:

Renamed tab

5.2.2 Deleting tabs
If a tab is no longer required, it is possible to delete it. Simply click on the close icon on the relevant tab:
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5 Display configuration

Delete tab

5.2.3 Renaming Quantum screen
In addition to renaming each display tab, it is also possible to rename the title displayed at the top of the 
Quantum screen. The default name is System 1. It is recommended to set a descriptive name such as 
DGNSS Port or Vessel Secondary.

To rename the Quantum screen name, double-click the existing name e.g. System 1:

Quantum screen name
 

The new name can be entered using the on-screen keyboard then pressing Enter to confirm:
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5 Display configuration

New Quantum screen name

NOTE
The name is restricted to 32 characters and no special characters are permitted.
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6 Views

6 Views
There are many views available which allow the user to monitor system status. Some of these views 
relate to the overall solution status and some show more detailed information relating to either GNSS, 
correction or heading data.

The user can decide which views are most relevant for their requirements and arrange them accordingly.

6.1 Selecting views
To manually select views, select the relevant Tab display (either existing or a new tab). Press the Menu 
icon followed by the ‘+’ symbol then the View icon (highlighted far right below):

Accessing manual views

After clicking the View icon, the icons below will be displayed:

View icons

The available views are split into seven categories, detailed in later sections, these are:

Correction View Heading & 
INS View

GNSS Status 
View

Interference
and 
Spoofing 
View

Solutions View Tides View

 System Status 
View  
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NOTE
Heading and Tides tabs are present when Quantum has the feature included within 
the software license.

Click on the required category to access the available views. Once the required view has been found, 
press and hold the left mouse cursor and drag to the desired tile.

While dragging the selected view, tiles will be highlighted with a green border or a red border. Green 
indicates that the view is ok to be placed and red denotes the view is an incompatible shape for this tile.

Tile placement restrictions
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A selected view must be placed into an appropriate shaped tile dimension:

View placed in appropriate tile

 

6.1.1 Different types of tiles available
There are different types of tiles available within views. Namely 1*1, 2*1, 2*2, 3*3, 4*4:

Different types of tiles available (1*1, 2*1, 2*2 & 3*3)

Different types of tiles available (2*2 & 4*4)
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6.1.2 Deleting view from tiles
If a tile contains information which is no longer required, it is possible to delete the contents of the tile. 
Simply click on the ‘X’ icon on the relevant tile:

Delete tile contents
 

6.1.3 Replacing existing views
A tile does not need to be empty before a new view can be inserted into a tile. If a tile contains data which 
is no longer required, a new view can be inserted using the same method as explained in section 
Selecting views.

6.2 Correction View - Descriptions

6.2.1 Correction Link Status (LD8)
The Correction Link Status view provides high level information regarding various aspects of the L-
band corrections in use. Note the information displayed will depend on the size of tile used:

LD8 Correction Link Status 1x1 view (and) 2x1 view
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Information Details
L-band satellite in use Name of the L-band correction satellite in use e.g. AUTO, or 25E

Enabled Green icon = Enabled 
Red icon = Disabled 

Locked Green icon = Signal locked
Red icon = No signal lock 

Sync Green = Receiving data from L-band satellite
Red = Not receiving data from L-band satellite 

Signal Strength Signal strength of the selected L-band satellite. Thresholds: Green: >36.5dB 
Hz, Amber: Between 32.5 & 36.5dB Hz:, Red: <32.5dB Hz

NTRIP
Green icon = NTRIP correction active
Grey icon = NTRIP not configured
Red icon = NTRIP configured but no corrections received

Azimuth & Elevation Orientation info' for active L-band correction satellite at present location.

6.2.2 Correction Link Status (LD900)
The Correction Link Status view provides high level information regarding various aspects of the L-
band corrections in use. Note the information displayed will depend on the size of tile used, with toggling 
between LBAND and GNSS1 available on the 2x1 view, allowing for verification of individual beam 
states:

LD900 Correction Link Status 1x1 view (and) 2x1 view

Information Details
LBAND (1x1, 2x1 tiles) Name of the L-band correction satellite in use e.g. AUTO, or 25E

GNSS1 (1x1 tile) Name of the L-band correction satellite in use e.g. AUTO, or 25E

Enabled Green icon = Enabled 
Red icon = Disabled 

Locked Green icon = Signal locked
Red icon = No signal lock 

Sync Green = Receiving data from L-band satellite
Red = Not receiving data from L-band satellite 
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Information Details

Signal Strength Signal strength of the selected L-band satellite. Thresholds: Green: >36.5dB 
Hz, Amber: Between 32.5 & 36.5dB Hz:, Red: <32.5dB Hz

NTRIP
Green icon = NTRIP correction active
Grey icon = NTRIP not configured
Red icon = NTRIP configured but no corrections received

6.2.3 Correction Age
The Correction Age view shows a breakdown of L-band corrections which the Veripos receiver is 
enabled for. This view can be used to monitor correction age for all corrections types. The symbols have 
three colour states based on the current correction age.

Correction types that the Veripos receiver is not enabled for are indicated by a grey icon with a cross.  In 
the example shown below, the system is enabled for Apex Pro, Ultra2 and Standard2:

Correction Age

The table below details the default correction age range which determine the colour of the status icons 
for each correction service:

Veripos Correction 
type 

Green = time left 
(seconds) 

Amber = time left 
(seconds) 

Red = time left 
(seconds)

Apex 0 – 179 180 – 359 ≥ 360

Ultra 0 – 179 180 – 359 ≥ 360 

Standard 0 – 79 80 – 119 ≥ 120
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When displayed in a 1x1 sized tile, the Correction Age view provides high level information of the overall 
service (no breakdown of each GNSS constellation):

Correction Age view – 1x1 tile

6.2.4 Correction Link Satellites
The Correction Link Satellites view displays al visible l L-band correction satellites (using a satellite 
symbol) with an elevation of greater than 0° at the user’s location.

The polar plot view shows the approximate elevation and azimuth to the correction satellite at the current 
location. The selected correction satellite will be denoted with the largest satellite symbol:

Correction Link Satellites view
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6.2.5 Correction Latency
Provides a dynamic display of the correction age (latency). The correction latency bars are colour-coded 
depending on their value.

By default, the latency bars will count down from their maximum allowable latency value. This makes it 
clear to the user exactly how long they have until that particular solution will timeout (when latency 
indicator bar reaches zero). A ‘Time Left’ value is also displayed to confirm how long each solution has 
until it reaches the maximum allowable correction age:

Correction Latency – Age counting down
 

Veripos Correction 
type 

Green = time left 
(seconds) 

Amber = time left 
(seconds) 

Red = time left 
(seconds)

Apex 0 – 179 180 – 359 ≥ 360

Ultra 0 – 179 180 – 359 ≥ 360 

Standard 0 – 79 80 – 119 ≥ 120

Correction Latency – Age counting up

For details on where to set the Correction indicator direction refer to section Latency Indicator 
Direction.
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The latency bars are colour coded. The tables below show the threshold ranges (count-up and count-
down):

Veripos Correction 
type 

Green = time left 
(seconds) 

Amber = time left 
(seconds) 

Red = time left 
(seconds)

Apex 0 – 179 180 – 359 ≥ 360

Ultra 0 – 179 180 – 359 ≥ 360 

Standard 0 – 79 80 – 119 ≥ 120

6.2.6 Correction Link Signal Strength
The Correction Link Signal Strength view is a fuel gauge-type view which provides real-time LBAND 
or GNSS1 signal strength indications. The view is colour-coded to give a clear visual indication if the 
signal strength is acceptable:

Correction Link Signal Strength view

6.2.7 Correction Link Signal Strength – Time Series
Shows a graphical plot of LBAND or GNSS1 signal strength over the previous 10 minutes:

Correction Link Signal Strength – Time Series view
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6.2.8 Service Correction Availability
Displays information regarding the availability of correction data for each Veripos service.

For Apex and Ultra solutions, the number of GNSS satellites with correction data is displayed in green 
numbers. GNSS satellites which have no correction data available are displayed in red numbers:

Service Correction Availability view

NOTE
The values in this view are based on all satellites above the horizon (0° elevation).     
These values may differ from the number of satellites used in a solution which has     
an elevation mask e.g. 7°.   

For Standard solutions the number of Veripos DGNSS reference stations within range of the users’ 
location are shown as the Total Reference Stations.

The number of reference stations for which GPS and GLONASS corrections are currently being received 
for will be displayed in the GPS and GLONASS bars:

Service Correction Availability – Standard solution

Veripos Standard solutions will use a maximum of 6 reference stations even if there are more reference 
stations within range.
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6.2.9 SBAS Status
Displays information regarding the availability of SBAS signal status.

SBAS Status view

Signal Strength is displayed in dBHZ

PRN Unique PRN code of satellite in use.

Status is shown as a Green, Amber or Red Icon, Green indicates a healthy status, Amber is marginal 
and Red indicates an unhealthy status.

 

6.2.10 MF Status (LD900 Only)
Displays information regarding the availability of IALA signal status.

MF Status
 

Signal Strength is displayed in dBuV

Station ID is unique for each IALA reference station, this ID can be used to determine which IALA station 
is being received. Where no station is available the Station ID will display 1024.

WER (Word Error Rate) is ideally 0% which means there are no errors within the decoded data.

A healthy SNR (Signal to Noise Ratio) will be indicated with a green indicator, amber indicates a marginal 
signal and red indicates an unhealthy SNR.
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UHF Status (LD900 Only)

UHF Status
 

Signal Strength is displayed in dBm

Frequency in MHz of the selected UHF channel

Link Rate is 4800 BPS.

Status is shown as a Green, Amber or Red Icon, Green indicates a healthy status, Amber is marginal 
and Red indicates an unhealthy status.

6.3 GNSS Status View - Descriptions

6.3.1 GNSS Availability
Provides information regarding GNSS satellite status:

• Healthy How many useable satellites are tracked
• Missing Number of satellites not tracked
• Unhealthy Number of satellites which are not available for use

GNSS Availability view
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6.3.2 GNSS Missing Satellites
Plots the location of any satellites which should be available at the user’s location but are not currently 
being tracked.

Failure to track available satellites could be due to various reasons, such as masking (blockage) or poor 
cable or antenna installation. If there are a significant number of missing satellites highlighted in this 
display, steps should be taken to investigate the cause.

GNSS Missing Satellites view
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6.3.3 GNSS Signal Level
Shows the signal strength, measured in dB Hz for each GNSS satellite in view. There is a toggle switch in 
the top right of the window, allowing for different signals to be selected. The below example shows GPS 
satellite signal strengths, with a toggle option to display L1, L2 or L5 signals.

GNSS Signal Levels view on 4X4 tile

The image below shows the GNSS Signal Level 2x1 tile with a toggle switch toggle switch in the top right 
of the window, allowing for different signals to be selected.

 

GNSS Signal Levels on 2x1 tile

GNSS satellites are sorted from left to right by elevation, from lowest to highest.

Veripos solutions have a default GNSS elevation mask of 10°, GNSS satellites that are tracked (but 
below 10° elevation) will be rejected from the solution. The blue area at the origin of the graph highlights 
the elevation from 0° to 10°. Satellites within this area will not be used in any solution.

The signal strengths shown are colour-coded to indicate if current signal strengths of tracked satellites 
are acceptable.

Fluctuations in a satellite signal strength will show as a light blue area at the top of the bar graph plot. 
Large fluctuations indicate that satellite signal tracking is unstable, which is typical for satellites tracked at 
low elevations; however, this is also a symptom of multi-path or interference.
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GNSS signal level variation
 

The configurable colour-coding thresholds are set to Veripos default values.
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6.3.4 GNSS Signal Level Alt
Displays the same information as the GNSS Signal Level view but in a different graphical style:

GNSS Signal Level Alt on 4x4 view
 

Recent fluctuation in a satellite signal strength are highlighted by a vertical white line:

GNSS signal level variation
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GNSS Signal Level Alt view on 2x2 view
 

6.3.5 Satellite Polar Plot
The satellite Polar Plot provides situational awareness, visually representing  the orientation of GNSS 
constellations in relation to the vessel heading. Besides the ability to display heading if available and 
enabled, the Satellite Polar Plot has the following functions:

Satellite 
(type) Description

Tracked 
satellites

Displays all GNSS satellites currently tracked in 
green

Tracked 
satellites (not 
used)

Displays all GNSS satellites  tracked but not used 
by active solution in grey

Missing 
satellites Displays any GNSS satellites not available in red

Correction link 
satellites

Displays the calculated position of the L Band 
satellites visible at the vessel's current position

107Quantum User Manual



6 Views

Satellite Polar Plot view on 4X4 view

This 4 x 4 view can be configured to show information for specific GNSS Satellite constellations. The 3 x 
3 tile polar plot view cannot be customised:

Satellite Polar Plot view on 3X3 view with no toggles
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6.3.6 DOP
Displays the current solution DOP values (HDOP, PDOP and VDOP) of the current solution in green, 
amber and red when they are in good (<2), warning (2 - 4) and bad (>4) states.

DOP view

6.3.7 24 Hour DOP Prediction
Designed to alert the user to periods where the DOP values are predicted to be high. The ability to predict 
high DOP periods can assist the user to mitigate risks and to maintain additional vigilance. This view can 
be placed on either a 1x1 or 2x1 tile:

24 Hour DOP Prediction view

 

109Quantum User Manual



6 Views

If no DOP issues are predicted, the main section of the view will be empty and only real-time DOP values 
(HDOP, PDOP and VDOP) will be displayed:

24 Hour DOP Prediction view – No events

6.3.8 DOP Status
Displays details of current DOP events. ‘DOP events’ are periods when DOP values are unusually high, 
normally because of a low satellite count or poor satellite geometry:

DOP Status view

 

If there are no current DOP events, the main portion of the view will be empty and only real-time DOP 
values will be displayed. This view can be placed on either 1x1 or 2x1 tile:

DOP Status view – No events
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6.4 Solutions View - Descriptions

6.4.1 Solution Plot
Displays a polar plot with an error ellipse of the current and backup solution (where available):

Solutions Plot

The scale of the polar plot can also be changed using the scale slider. Scales range from 50cm to 10m. 
The Solution Plot view centres on the active solution and the error ellipse for the backup solution is 
displayed relative to the active solution. Solution error ellipses can be selected using the solution slider.

6.4.2 Solution Difference
Displays delta values (dEast and dNorth) of the backup solutions relative to the primary solution. Large 
delta values indicate that the active or backup solution is not accurate and requires investigation.

Solution Difference
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6.4.3 Solution Status
Displays the status of the active and backup solution:

Solution Status view - PPP

For PPP solutions, this view shows the number of GNSS satellites used (detailed by GNSS 
constellation). Green bars indicate how many satellites from each GNSS constellation are used. Amber 
values indicate satellites that are rejected or uncorrected and therefore not used in the solution. The 
current solution DOP values (HDOP, PDOP and VDOP) of the selected solution is displayed.

For Veripos Standard solutions, the number of reference stations used is displayed in green:

Solution Status view – Standard
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6.4.4 UKOOA Statistics (Quantum Survey only)
Displays the following statistical information:

• F-Test status

• W-Test status

• MDE value

• Semi-major value

Choose to display either the active or a backup solution information using the tick-boxes. The error 
ellipse for the selected solution will also be displayed, where the scale can be adjusted:

UKOOA Statistics view

NOTE
The UKOOA statistics view is only available when Quantum is enabled with a      
Survey license.   
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6.4.5 2d-SD Time Series
Displays a graph (which is auto-scaled) of the active solution 2d-SD (horizontal standard deviation) value 
for the last 10 minutes. The 2d-SD values shown are at 2σ (95%) confidence.

2d-SD – Time Series view

6.4.6 Secondary Position
Displays the solution, current 2d-SD (horizontal standard deviation) value, number of satellites used in 
the calculation and the HDOP.

Secondary Position view

 

114Quantum User Manual



6 Views

6.5  Heading and INS View - Descriptions
Heading views are unavailable unless the Quantum Heading feature is activated. Please refer to section 
Quantum - Software licenses for further details.

6.5.1 Heading

Heading view

This view graphically displays vessel heading, vessel trail and Course over Ground (CoG) with numerical 
values for heading, COG and speed over ground (SOG) are also shown in the top right. 

 l Heading (HDG) refers to the direction in which a vessel's bow (front) points relative to the Earth's 
reference frame, measured in degrees clockwise from true north. HDG is crucial for navigational 
assistance, course-plotting, and determining the vessel's orientation in relation to its intended 
destination or other vessels in the vicinity.

 l Course Over Ground (COG) refers to the actual direction in which a vessel is moving relative to 
the Earth's surface, regardless of its heading, as influenced by factors such as the vessel's 
heading, current, wind, and other external forces.

 l Speed over Ground (SOG) represents the actual speed, measured in  knots, of vessel movement 
relative to the Earth's surface as determined by combining the vessel's speed through the water 
while influenced by the effect of external forces such as currents or tides.
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The heading value is additionally indicated by a small rectangle (same colour as the vessel shape) on 
marked on the graticule. A brown arrow indicates the course:

Heading and COG indicators
 

This view also displays the vessel track plots (if enabled). The scale of the view may need to be adjusted 
to allow the vessel track plot to be visible:

Vessel track plot view
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The vessel shape shown on the graphical views can be either a generic ship or generic rig as configured 
in the Settings - Display section:

Heading views – Ship shape (left), Rig shape (right)

6.5.2 Heading Data

Displays the Heading (HDG), Course (COG) and 
Speed (SOG)and the heading standard deviation 
(SD). A lower heading SD indicates a more 
accurate heading solution.

Heading Data
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6.5.3 Surge and Sway
Provides an indication of vessel Forward/Aft (Surge) and Port/Starboard (Sway) movement in terms of 
direction and speed.

Blue direction arrows indicate movement in that direction (in relation to vessel North). The direction 
arrows also show the speed (knots) in which the vessel is moving in each axis.

Overall vessel heading, CoG, SOG and vessel heading SD are also displayed:

Surge and Sway view

NOTE
The layout of the Surge and Sway view will vary depending on the tile size it is 
placed in.

6.5.4 INS Data

LD900 and LD900M models licensed for INS can 
use the INS Heading Data view. Once INS has 
been interfaced and configured, this view will 
populate with INS Heading, Pitch, Roll, Heave and 
Status (Good, Aligned, INS Aligning, High Variance 
or Error) values.

118Quantum User Manual



6 Views

6.5.5 Heave
The Heave tile plots the vessel heave (metres) on a time series plot. Heave is the short term vertical 
displacement of a vessel relative to the mean of the sea state caused by wave or swells.
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6.6 Interference and Spoofing View - Descriptions
Quantum has a licensed capability of enabling digital RF filters to protect (by approximately 30 dBs) the 
LD8 or LD900 positioning computation against RF interference. An active Interference Mitigation license 
is required to configure and apply Interference Mitigation, without which the configuration options will not 
be visible. See the Quantum Software licenses section for more information.

NOTE
Without an active Interference Mitigation  license, users can still  access RF 
spectrum monitoring and spoofing detection functions.

6.6.1 Spoofing Status
To display information relating to spoofing status, spoofing must first be activated and calibrated in 
Settings > System Configuration > Receiver Management. Will display ‘Spoofing is not calibrated’ 
until calibration/activation.

Spoofing detection requires calibration. Without calibration the spoofing detect function is not active.

Calibration will remain ‘Uncalibrated’ until Start Calibration is initiated in Settings and the calibration is 
successfully completed. Once Start Calibration is activated, Calibration will switch to 'Calibrating' and 
then to ‘Passed’ once it is complete.

A Calibration status of ‘Failed’ will indicate that calibration has not been successful and that it must be re-
attempted.

Upon successful spoofing detection calibration, the Calibration status will change to Passed and Last 
Calibration will display the UTC date and time of the successful calibration.
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6.6.2 Interference Status
Displays the high-level interference status. If interference is detected, the GNSS frequency band and the 
centre frequency (Mhz) of the interference will be indicated.

         Interference Status tile with an L2 interference example

6.6.3 RF Spectrum
The RF Spectrum view monitors and identifies any potential interference source. The Spectrum view 
can determine an interfering signal's centre frequency, bandwidth, amplitude, and the GNSS signal 
bands potentially subject to impact (L1, L2, L5 and L-band signal bands). The initial view shows the GPS 
L1 spectrum. The example below highlights a settings cog icon in the top right, which provides RF 
Spectrum and HDR Mode configuration options.

RF Spectrum view with Frequency (MHz) on X axis and Power dBm on Y axis.
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6.6.3.1 RF Spectrum tab

Clicking on the RF Spectrum settings icon will open the Configure RF Spectrum window, allowing users 
to select particular frequencies (L1, L2, L5 and L-BAND), which will change the RF Spectrum view 
accordingly, allowing for the monitoring of received signals  used by different GNSS systems and their 
associated signal type.

To focus on a particular area of the radio spectrum, the user first selects WIDE BAND (pre-selected), 
PASS BAND or FILTER BAND (the filter band is only visible when an ITK license is enabled).

Clicking upon PASS BAND presents an option to toggle between specific frequency signals such as, in 
the case of the L1 frequency, 'GPSL1', 'GLONASSL1', 'BEIDOUB1I', 'BEIDOUB1C'  and 'GALILEOE1'.

As detailed in the next section, a filter must be defined and active to select the FILTER BAND view.
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6.6.3.2 Filters tab

With an active ITK software license option, Quantum can configure and apply digital RF filters (a 
maximum of two filters) within the interfaced LD8 or LD900 receiver. These software filters can provide 
up to 30 dBs of protection from unwanted RF signals.

To illustrate the use of filters, consider an example scenario of an interfering signal at carrier 1582.5 MHz 
with a 100 KHz bandwidth. Initially, the user can observe interference within the RF Spectrum Pass Band 
- GPS L1 view. The spectrum view allows the user to estimate the centre frequency of the interfering 
carrier and to estimate the interference power:

Interference identified within the RF Spectrum Pass Band - GPS L1 view

The spectrum view lets the user estimate the interfering carrier's centre frequency and interference 
power. A logical first step would be to enable HDR Mode for the L1 signal band: 
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The user selects the filters tab and adds a notch filter at 1582.5 MHz with a 1Mhz bandwidth. Shown 
below are the filter configuration options, with the chosen values highlighted. Parameters are set and 
applied:

The red and green graphic at the bottom of the filter configuration window illustrates the frequency of the 
notch filter (red) and the mirrored filter, which is a byproduct. The green section denotes the part of the 
spectrum reserved for the signal; in this example, GPS L1 centred on 1575.42 MHz:

The spectrum view now displays an active GPS L1 Notch filter:
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Selecting the filter band view allows observation of the effectiveness of the GPS L1 filter. This view is 
only available once a filter is active:

The GPS L1 filter view: 
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The notch filter is visible, with a second notch filter created as an automatic byproduct of the software 
filtering. The interference peak is still visible but suppressed. With the GPS L1 notch filter active, we can 
note the GPS L1 SNR values return to normal and stable signal strengths.

6.6.3.3 HDR Mode tab

Selecting the HDR Mode tab provides the ability to enable HDR (High Dynamic Range) Mode on L1, L2, 
L5, Primary L-band and Secondary L-band frequency bands. HDR mode assists with signal tracking 
when signal strength is low or interference is present. If any signal tracking issues occur (interference, 
low or no signal tracking), enabling HDR Mode will help restore signal tracking.
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6.7 Tides View – Descriptions
Tides views are not available unless the Quantum Tides feature is activated with the Quantum Software 
license. Please refer to section Quantum - Software licenses for further details.

6.7.1 Tides - GNSS
The Tides-GNSS view displays following information:

• Min Height - Smallest position height in the last interval

• Max Height - Largest position height in the last interval

• Mean Height - Mean of the position heights within the last interval

• Height SD - SD of the sample heights in the last interval

• Sample Count - Percentage of available samples for the current interval

Tides GNSS view

6.7.2 Tides - Doodson
The Tides - Doodson view displays following information:

• Mean - Mean MSS tide is the mean of all tides above MSS estimated by the Doodson filter.

• Latest - Latest MSS tide is the tide above MSS estimated by the Doodson filter.

• Draft - Calculated as the current Doodson value minus the Doodson value for the first record.

Tides Doodson view
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NOTE
There is a 39 hour  initialisation period for Quantum to calculate Tides Doodson 
values.

6.7.3 Tides – Status
The Tides - Status view displays following information:

Information Details

Sample 
Count

Displayed if sufficient samples during the last 
interval were used.
Green=True (at least 50%) 
Red=False 

Data Gap 
Identifier

Displayed if a data gap is detected (data gaps 
are not desired)
Green icon=True (attention required)
Red icon=False (this is desired status) 

Hold off 
Period

Status showing if the hold-off period is active.
Green=True
Red=False 

Tides - Status view
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If the Hold-off Period is active (green), then a Hold off countdown bar is displayed. The bar shows the 
remaining time until the end of the hold-off period is reached:

Tides Status view – Hold off period active

6.7.4 Resource Use
Displays the disk space used within the tides folder:

Tides - Resource Use

6.7.5 Tides – PPP Height – Time Series
Displays the maximum (green) average (blue) and minimum (red) PPP height values (metres) over time 
(past 72 hours).

Tides - PPP Height - Times Series
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6.8 System Status View

6.8.1 System Status
Displays the status of the hardware platform on which Quantum is operational:

System Status

6.8.2 PTP Status
Displays PTP status, indicating if PTP mode is enabled and if the receiver is providing GPS time to 
synchronise clocks on other network equipment.

PTP Status
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7 Troubleshooting
Use this section to assist with any problems encountered when using Quantum. Significant errors will 
trigger system notifications. These notifications will provide advice on how to troubleshoot the issue.

Example problem 1

Upon configuring Quantum on a PC to connect to a Veripos receiver, the following message appears:

Solution

Check the receiver IP address and ensure that the IP address entered in Quantum is correct. Also 
ensure the correct receiver type is selected during configuration.  Check that the Ethernet cable is 
properly connected between the Veripos receiver and the Quantum PC. 
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Example problem 2

When using Quantum, with a software license obtained for existing PC and then attempting to launch 
Quantum on another PC using the same license, the following message will be displayed:

Solution

The license code used on the previous PC is still valid, this license must be entered on the new Quantum 
PC. Go to the Authorisations menu on the previous Quantum PC, copy the Quantum software license 
and then enter the same license on the new PC. If it is not possible to recover the code from the old PC, 
contact the Veripos Helpdesk who will be able to provide the license code.
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Example problem 3

Quantum is flashing red and none of the display tiles are populated:

Solution

Check the Notifications Tab. Notifications in the Status section should provide an insight into why the 
Quantum system is alarming.

If the Veripos receiver in-use is working normally, check the Ethernet connection to the Quantum PC.

Check the status of the Veriposreceiver in-use. If the receiver also shows a loss of position or 
corrections, check antenna(s) and cabling.
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Example problem 4

Sidebar has an amber border:

Solution

An amber sidebar indicates a non-critical issue with either the active or backup solution.

If, as shown in the example above, there is a blue spinner displayed next to one of the solutions, this 
indicates that the solution is currently converging. No action is required; the solution will settle after 
around 30 minutes.

Other situations can cause an amber sidebar, such as the backup solution being uncorrected, active 
solution having timed-out and system reverting to the backup solution.
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Example problem 5

A heading input is configured in Quantum, but no heading views can be selected

Solution

To display heading information, the Quantum license must include the heading feature. Check the 
Authorisations page to confirm if there is an active heading license. Contact the Veripos Helpdesk to 
activate if required.

 

Example problem 6

A Veripos receiver is subscribed to the Apex Pro service, but the Quantum display suggests that not all 
available constellations are being used:

Solution 

Not all constellations are available at all locations. The Apex5 solution utilises a number of GNSS 
constellations. The solution actively adds or remove constellations as they become available or 
unavailable.
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8 Reference information
8.1 Tides formats

8.1.1 Tideinfo file format
Tideinfo file format description

The TideInfo.txt file contains current system height and tide information at the Averaging Period as 
configured by the user. This file contains comma delimited strings with variable length fields. Null fields 
indicate that no information is currently available; they should not be interpreted as ’zero’. A checksum is 
included for extra robustness. Negative tide is low tide and positive tide is high tide respectively.

Tideinfo sentence structure & example

$UltraTide,20070228,21:40:00,28,600,600,5236.2830,N,00143.5184,E,5.74,0.08,0.07,5.66,5.82,5.45,0
.29,0.02,5.72,44.84,0.00,0.27,EGM96*2B

Tideinfo sentence defined

Content Format Unit Notes

0 TalkerID [-] $UltraTide or $ApexTide (dependent on active PPP 
calculation)

1 yyyymmdd [-] Identifies year, month and day for which all information in 
the string is valid.

2 Time (UTC 
or GPS)

hh:mm:ss (UTC)

or 

ssssssssss 
(GPS) 

Identifies time in UTC or GPS for which all information in the 
string is valid.

3 Sequence 
Number numerical

Sequential number incrementing by 1 for each averaging 
period. Maximum is 99999999 after which an automatic 
reset back to 1 takes place.

4 Averaging 
Period numerical

User selected period over which Veripos Apex or Ultra 
heights are averaged in seconds. Minimum is 60, maximum 
is 3600.

5 Sample 
Count numerical

Represents the total number of Veripos Apex or Ultra PPP 
height samples collected during the averaging period, which 
are used to calculate the average PPP height. A minimum of 
50% of the defined 'Averaging Period' is required to produce 
a valid sample count. This count remains constant 
throughout each epoch, updating only at the end of each 
new averaging period.

6 Latitude

ddmm.mmmm

(degrees, 
minutes and 

Location where height and tide information is valid. 
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Content Format Unit Notes
decimal 
minutes)

7 Latitude 
Hemisphere c N or S

8 Longitude

dddmm.mmmm

(degrees, 
minutes and 
decimal 
minutes)

Location where height and tide information is valid. 

9 Longitude 
Hemisphere c E or W

10 Mean Height hh.hh (metres) Mean of the Veripos Apex or Ultra heights during the 
‘Averaging Period’

11 Mean of 
Height SD hh.hh (metres)

Mean of the Height SD’s associated with the Veripos Apex 
or Ultra heights during the ‘Averaging Period’. This is an 
indication of the quality of the Veripos Apex or Ultra heights

12 SD of 
Heights hh.hh (metres)

Standard deviation of the Veripos Apex or Ultra heights 
during the ‘Averaging Period’. This is an indication if the 
variation of the height due to vessel motion and position 
quality.

13 Minimum of 
Heights hh.hh (metres) Minimum of theVeripos Apex or Ultra heights during the 

‘Averaging Period’

14 Maximum of 
Heights hh.hh (metres) Maximum of theVeripos Apex or Ultra heights during the 

‘Averaging Period’

15 Doodson hh.hh (metres) Estimated antenna height above Mean Sea Surface from 
the Doodson filter. First available after 39 hours.

16 MSS Tide hh.hh (metres) Local tide based on the Mean Sea Surface derived from the 
Doodson filter. First available after 39 hours.

17 Geoid Tide hh.hh (metres) Local tide relative to user selected Geoid (see field 22). 
Available instantaneously after ‘hold-off’ time

18 Antenna 
Height hh.hh (metres) User entered height of the antenna above the waterline.

19 Geoid 
Separation hh.hh (metres) Local offset between the user selected Geoid and the 

WGS84 reference ellipsoid.

20 Draft hh.hh (metres) The draft. Calculated as the current Doodson value minus 
the Doodson value for the first record.

21 Vertical Bias hh.hh (metres)
The vertical bias detected between MSS Tide and Geoid 
Tide. Calculated as Antenna Height minus Doodson plus 
Draft.
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Content Format Unit Notes
22 Geoid Model - EGM96, EGM08 or USER

8.1.2 Sprint_Tides file format
Sprint_Tides file format description

The SPRINT_Tides.txt file contains the current UltraTide with the opposite sign compared to the MSS 
Tide contained in the TideInfo.txt and Doodson.txt files. This file contains comma delimited strings with 
variable length fields. Null fields indicate that no information is currently available; they should not be 
interpreted as ’zero’. A checksum is included for extra robustness. Negative tide is high tide and positive 
tide is low tide respectively.

Sprint_Tides sentence structure & example

12,20,22,09,2006,-0.88

Sprint_Tides sentence defined

Content Format Unit Notes

0 Hours HH Hours in the day (UTC). Time for which all information in the string is 
valid.

1 Minutes MM Minutes in the day (UTC). Time for which all information in the string is 
valid.

2 Day DD Day in the month.

3 Month MM Month in the year.

4 Year YYYY Year.

5 UltraTide hh.hh 
(metres)

Local UltraTide based on the Mean Sea Surface derived from the 
Doodson filter. First available after 39 hours. Set as 99999.99 when no 
UltraTide value is available.

 * c Fixed end delimiter (real time output only)

  cc Checksum (real time output only)

138Quantum User Manual



8 Reference information

8.2 Heading formats

8.2.1 HDT heading string format
Quantum allows for input of external heading sources for display purposes, using the NMEA HDT 
sentence format.

HDT sentence structure & example

$GNHDT dd.dddd, T hh
$GNHDT 75.5664, T *36

HDT sentence defined

Field Content
HDT Heading (true) message

dd.dddd Heading in degrees

T Degrees True

*hh Checksum

8.2.2 THS heading string format
Quantum allows for input of external heading sources for display purposes, using the NMEA THS 
sentence format.

THS sentence structure & example

$GNTHS dd.dd, T *hh
$GNTHS 125.5, T *2F

THS sentence defined

Field Content
THS True heading speed message

dd.dd Heading in degrees

T Degrees True

*hh Checksum
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8.3 Alert management sentence formats

8.3.1 ALC cyclic alert list string format
Quantum transmits  alert status updates using an ALC sentence format.

ALC sentence structure with no active alerts

$GNALC aa bb null c *hh
$GNALC, 01, 01, , 0 *77 

ALC sentence structure with one active alert

$GNALC aa bb null c DDD eeeeee null f *hh
$GNALC, 01, 01, , 1, HGN, 100001, , 1 *06

ALC sentence structure with two active alerts

$GNALC aa bb null c DDD eeeeee null DDD eeeeee null f *hh
$GNALC, 01, 01, , 2, HGN, 100002, , HGN, 100001, , 1 *76

ALC sentence defined

Field Content
ALC Cyclic alert list message

aa Total number of sentences

bb Current sentence number

null Sequential message identifier

c Number of alert entries (0 = no alerts, 1 = jamming or spoofing present, 2 = jamming 
and spoofing present)

DDD Manufacturer mnemonic code (Always HGN)

eeeeee Numeric identifier of the alert (100001 = Spoofing, 100002 = Jamming)

null Alert instance number

f Revision counter for the alert (1 = V, 2 = A)

*hh Checksum
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8.3.2 ALF alert sentence string format
Quantum transmits  alert status updates using an ALF sentence format.

ALF sentence structure with spoofing detected, unacknowledged

$GNALF a b null hhmmss.ss, C D E FFF, gggggg, null, h, i, J, *hh
$GNALF, 1, 1, , 091636.00, B, W, V, HGN, 100001 , , 1, 0, SPOOFINGDETECT, *4A

ALF sentence structure with spoofing detected, unacknowledged

$GNALF a b null hhmmss.ss, C D E FFF, gggggg, null, h, i, J, *hh
$GNALF, 1, 1, , 102711.70, B, W, A, HGN, 100002 , , 2, 0, JAMMINGDETECT, *1B

ALF sentence structure with jamming detected, cleared

$GNALF a b null hhmmss.ss, C D E FFF, gggggg, null, h, i, J, *hh
$GNALF, 1, 1, , 064445.87, B, W, N, HGN, 100002 , , 2, 0, JAMMINGDETECT, *1F

ALF sentence defined

Field Content
ALF Alert sentence 

a Total number of sentences

b Current sentence number

null Sequential message identifier

hhmmss.ss, UTC time of the last alert status update

C Alert category  (Always B)

D Alert priority (Always W)

E Alert State (A = ACN acknowledged Spoofing/Jamming, N – Nominal, V ACN 
Unacknowledged Spoofing/Jamming)

FFF Manufacturer mnemonic code  (Always HGN)

gggggg Numeric identifier of the alert (100001 = Spoofing, 100002 = Jamming)

null Alert instance number

h Revision counter for the alert (1 = V, 2 = N or 1 = V, 2 = A, 3 = N)

i Escalation counter

J Alert Text (Spoofing = “SPOOFINGDETECT,  Jamming = “JAMMINGDETECT”)

*hh Checksum
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8.3.3 ACN alert command string format
Quantum supports alert control input via an ACN sentence format and provides systems a means to 
acknowledge or request a repeat of alert details.

ACN sentence structure, acknowledge spoofing alert example

$IIACN hhmmss.ss, AAA, AlertID, null, Command, StatusFlag *hh
$IIACN 112524.01, CAM, 100001, , A, C *28

ACN sentence structure, retransmit jamming example

$IIACN hhmmss.ss, AAA, AlertID, null, Command, StatusFlag *hh
$IIACN 143623.15, CAM, 100002, , Q, C *3E

ACN sentence defined

Field Content
ACN Alert command

hhmmss.ss UTC time of the alert condition (Can be null)

AAA Manufacturer mnemonic code

AlertID Numeric identifier of the alert (100001 = Spoofing, 100002 = Jamming)

Instance Alert instance number

Command Command type (Quantum expects A = Acknowledge or Q = Query)

StatusFlag Sentence status flag (Always 'C' = Command issued)

*hh Checksum

142Quantum User Manual



9 Contact information

9 Contact information
All initial contacts regarding technical or support issues should be initially addressed to Veripos Support. 
Where appropriate Support will refer issues to the regional operations and engineering teams.

9.1 Veripos Support details
Veripos Support website https://veripos.com/support
Veripos Support telephone +44 1224 965900
Veripos Support e-mail support.veripos@hexagon.com
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10 Appendix

10 Appendix
10.1 Veripos PPP station ID’s

Service Station ID NMEA station ID
Ultra 68 0068

Ultra2 68 + 75 0268

Apex 81 0081

Apex2 81 + 82 0281

Apex5 / Apex Pro 81 + 82 + 91 + 92 + 62 0481*

*When Apex Pro solution uses less than four GNSS constellations, the NMEA station ID will change according to the number of 
constellations in-use e.g. 0381 if three constellations are in-use.

10.2 Veripos reference stations
The latest Veripos station listing can be found on the Veripos support website.
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10.3 L-band coverage map

10.3 L-band coverage map
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